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Getting Started

This section explains what SystemTest is and shows you how to use it. It

contains the following topics:

What Is SystemTest? (p. 1-2)

Quick Tour of SystemTest (p. 1-3)

Building a Test: An Example
(p. 1-10)

Introduces SystemTest and the
kinds of tasks it can perform

Provides a quick tour of the
SystemTest desktop

Describes building and running tests
with SystemTest



1 Getting Started

What Is SystemTest?

SystemTest provides MATLAB® and Simulink® users a framework that
integrates software, hardware, simulation, and other types of testing in one
environment. You use predefined elements to build test sections that simplify
the development and maintenance of standard test routines. You can save
and share tests throughout a development project to ensure standard and
repeatable test verification. SystemTest offers integrated data management
and analysis capabilities for creating and executing tests, and saving test
results to facilitate continuous testing across the development process.

SystemTest automates testing in MATLAB and Simulink products. With
SystemTest you get:

Graphical test editing — Quickly edit your test within a graphical test
development environment.

Repeatable test execution — All tests developed with SystemTest share the
same execution flow, which provides a consistent test framework among
tests.

Parameterized testing — Create test vectors over which your test iterates.

Reusability — After you design a test, you can save it for later use by you
or others.

Maintainability — Because you design and execute tests from within the
SystemTest desktop, you do not need to understand unfamiliar code or
concepts.

Integration — SystemTest integrates with MATLAB, Simulink, and other
MATLAB and Simulink-based products.



Quick Tour of SystemTest

Quick Tour of SystemTest
This section covers the following areas:

® “Getting Familiar with the Desktop” on page 1-3

® “General Desktop Features” on page 1-5

® “Setting SystemTest Preferences” on page 1-7

* “Viewing Test Results” on page 1-9

The SystemTest desktop is an integrated development environment that lets
you perform all of your testing activities from one centralized location. This
section provides a brief overview of the SystemTest environment. For more

information about how to use SystemTest to build tests and run them, see
“Building a Test: An Example” on page 1-10.

Getting Familiar with the Desktop

To get familiar with the SystemTest environment, open the SystemTest
desktop from MATLAB by selecting Start > MATLAB > SystemTest >
SystemTest Desktop or typing systemtest at the MATLAB command line.

1-3
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Add Test Elements » more

Create Test Vectors ) More

Create Test Variables) More
Save Results » more
Run the Test» More

Analyze Results With the Test Results Viewer

In order to build and run tests, there are certain steps you need to do
in SystemTest. You can do these steps in any order before running
your test. The following sections outline the necessary steps to build

You can switch between the Getting Started page and the Desktop
Help by clicking on the appropriate tab. fthis page is closed, you
can view it again by selecting Help > SystemTest Getting Started

More

The desktop has a number of different panes that aid you in building and
running your test.

¢ Test Browser — Shows the overall structure of a test. A test is made up of
Pre Test, Main Test, Save Results, and Post Test. Use the Test Browser to
add elements to your test. These elements determine what actions your
test performs.
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® Test Vectors — Lets you define the parameters or test cases of your test.
The test vectors you define determine the number of iterations performed
by your test. Test vectors are automatically indexed during test execution.

¢ Test Variables — Lets you define variables used in the scope of your test.
Variables can serve both input and output functions in your test. You can
define variables that are declared in the Pre Test section of your test or in
the Main Test section of your test.

¢ Properties — Shows the properties of the test or the element you are
editing. The contents of this pane change when you select a section or
element in your test.

* Getting Started — Shows information to help you start using SystemTest.
If the Getting Started page is closed, select Help > SystemTest Getting
Started to open it.

* Desktop Help — Shows help about the element or aspect of the test that
is currently selected. For the full product Help, select Help > SystemTest
User’s Guide.

¢ Run Status — Shows a summary of the test’s execution status.

General Desktop Features
The SystemTest desktop has a variety of features to make navigation easier.

Context Menus

Many areas of the user interface have context menus. For example, if you
right-click in the Test Vectors, Test Variables, Resources, Run Status,
Getting Started, or Desktop Help panes, you can access these context
menus.

If you have the Elements pane open, you can add elements to your test using
the context menus. If you right-click on any element there, you can insert

it directly into Pre Test, Main Test, or Post Test using the Elements pane
context menus. If that section of the test already contains elements, the
inserted element will be placed below the currently selected element in that
section. You can change the order of elements in the test by using the arrow
buttons in the Test Browser, or by drag and drop.
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Hot Keys

SystemTest offers various keyboard shortcuts, or hot keys, to access certain
commands via the keyboard. For example, F5 is an alternative way to run a
test, and Ctrl+N creates a new untitled test.

The full list of SystemTest hot keys is in Appendix A.

Undo/Redo Support

Undo and redo support is available through the Edit menu or on the
SystemTest toolbar. This feature allows you to undo actions you have done
throughout the desktop. The undo queue is global to the entire desktop. For
example if you add a test vector, and then perform an action in the Properties
pane, those two actions will be the last two items in the queue. The undo
order goes across all the panes in the desktop.

To use this feature, select the Edit > Undo <action> command, where
<action> is the last action you performed. Use the Undo command repeatedly
to undo multiple actions. The Edit > Redo <action> command will redo

the last undo you performed.

Most actions in the desktop are undoable. Note that some actions pertaining
to the elements that are part of the hardware toolboxes, Data Acquisition,
Instrument Control, and Image Acquisition, cannot be undone since they
involve connections to hardware.

The following actions will clear the list of actions in the Undo queue:

® (Closing a test
® Opening a test
® Creating a new test

¢ Refreshing a Simulink model in the Simulink element
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Setting SystemTest Preferences

You can set SystemTest preferences by selecting File > Preferences... on
the SystemTest desktop. This opens the MATLAB Preferences dialog box.
Click SystemTest in the left tree if SystemTest Preferences are not showing
in the right pane.

=101 ]

SystemTest Preferences

e Confirmation Dialogs:

i host Recently Used Test List
Source Contral i

FH-Keyboard furmber of entrigs: IE
[-Forts
----- Colors :
----- Comnmand Yyindosw Test Run Otions
""" Command History [ Minimize SystemTest when starting = test
[#-EditorDebugyer
------ Help [~ Savetest befare FURRInG
----- Web

----- Currert Directory
----- Array Editar

----- Time Series Toalz
[H-Figure Copy Templste
----- Report Generatar

----- SystemTest

----- Instrument Contral
H-wirtual Reslity

- Simulink

Ok I Cancel | Apply | Help |

Most Recently Used Test List

This option determines how many tests will appear on the SystemTest File
menu’s most recent files list. The default is 4 tests. If you change it to 0, no
recent tests will appear on the list. The maximum number is 9.
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Test Run Options

Select Minimize SystemTest when starting a test if you want the
SystemTest desktop to minimize when a test starts running. This check box
is cleared by default.

Select Save test before running if you want SystemTest to save your test
before it runs. If this option is selected and you run a test that is not yet
saved, you will be prompted to name and save the test. This check box is
selected by default.

Note You can save a test any time, before or after running it, by selecting
File > Save.

Confirmation Dialogs

You can also turn off confirmation dialogs used in SystemTest in a different
area of the Preferences dialog box by clicking General > Confirmation
Dialogs. Two SystemTest confirmation dialogs are listed there:

* Warn about launching Test Results Viewer without any saved
results — Occurs if you attempt to open the Test Results Viewer when the
latest test that ran does not contain any mapped results under Saved
Results. To save results, click Saved Results in the Test Browser.

* Warn about using a Simulink model with an infinite simulation
stop time — Occurs if you attempt to run a test containing a Simulink
element that uses a model with an infinite simulation stop time.
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These two warnings are shown in the following figure.
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Viewing Test Results

SystemTest includes a tool called the Test Results Viewer that you can use to
view the results you have chosen to save for your test. You can launch the tool
from the SystemTest Tools menu by selecting Tools > Test Results Viewer.
You can also configure the SystemTest environment to launch the Test Results
Viewer automatically after all test results you specified have been saved for
each iteration and test execution has completed. For more information, see
“Analyzing Your Test Results” on page 1-37.
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Building a Test: An Example

1-10

This section builds a simple example to illustrate the four primary stages of
testing: planning, building, and running the test, and viewing test results.

The example uses a simple MATLAB expression to emulate a scalar
measurement during each iteration of the test. The example uses an arbitrary
formula dependent on the test vector named signal to generate the Y data.
The example tests each measurement to determine if it falls within certain
specified limits. If a measurement exceeds these limits, that particular
iteration of the test fails. By default, the test fails if any iteration fails, but
you can configure other pass/fail criteria.

The following sections provide more information about each stage, building
the example test along the way. If you prefer, instead of working through the
following sections to build the example, you can load it into SystemTest by
running the Getting Started with SystemTest demo from the Demos page in
the MATLAB Help browser (under MATLAB > SystemTest > MATLAB) or
by entering systemtest Simple_Demo at the MATLAB command prompt.

¢ “Planning Your Test” on page 1-10

“Building Your Test” on page 1-11
¢ “Running Your Test” on page 1-33

“Analyzing Your Test Results” on page 1-37

Planning Your Test

In this first stage, you must identify what it is you want to test. SystemTest
lets you specify input data, such as measurements from a model or device, and
compare this input data to some predefined limits. Based on this comparison,
SystemTest can declare whether a test passes or fails. Keep the following in
mind as you plan tests:

¢ Identify your test data and test vectors.

e Specify test limits and determine if these limits can be expressed as scalar
or matrix values. (The Limit Check element supports both scalar and
matrix data.)
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® Determine what operations your test must perform. Must certain
operations happen before others?

® Determine pass/fail criteria for your test.
® Decide which test variables you want to save as test results.

After this planning, you can begin to construct your test, which is described in
“Building Your Test” on page 1-11.

Building Your Test

SystemTest provides a graphical integrated environment that you can use to
create and edit tests. Tests consist of elements, test vectors, and test variables.
You can use each of these entities to create a variety of test scenarios ranging
from a simple test that runs a series of elements once to a full parameter
sweep that iterates over the values of test vectors that you define.

The following sections show how to construct a test.

o “Starting SystemTest” on page 1-11

e “Structuring Your Test” on page 1-12

o “Creating a Test Vector” on page 1-13

® “Defining Test Variables” on page 1-17

¢ “Adding Elements” on page 1-19

® “Defining Pass/Fail Criteria” on page 1-29
* “Saving Test Results” on page 1-30

* “Test Report” on page 1-31

e “Saving Your Test” on page 1-33

Starting SystemTest

Start by opening the SystemTest desktop using the MATLAB Start button.
To open SystemTest, select Start > MATLAB > SystemTest > SystemTest
Desktop.

1-11
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1-12

Alternatively, you can execute the systemtest command from the MATLAB
command line.

SystemTest displays the desktop on your screen. See “Quick Tour of
SystemTest” on page 1-3 for an overview.

Structuring Your Test
SystemTest divides tests into three sections.

Pre Test — This section is used to execute test elements in order to perform
any test set-up operations, such as initializing variables, loading data from
a file, and initializing system resources. Using Pre Test variables, you

can assign an initial value to a test variable that persists between Main
Test section iterations (unless another element in Main Test modifies the
value). Pre Test is not mandatory, but it can be used if your test requires
set-up operations to be performed.

Main Test — Main Test defines the test elements that need to be
performed across the parameter space defined by your test vectors. In this
section Main Test variables are initialized before each Main Test iteration,
which lets you assign an initial value to a test variable each time the Main
Test runs. This is useful if your test variable has a derived value such as
being indexed by a test vector or is the result of a MATLAB expression.

The number of iterations performed in the Main Test is indicated in the
Test Browser in parentheses after Main Test. Iterations specifies the
number of times the Main Test section will be run. This is determined from
the test vectors you define. The SystemTest desktop also offers a Save
Results area for you to specify which test variables you want to save as
test results at the end of each Main Test iteration.

Post Test — In this section you can perform any cleanup work necessary
at the completion of the Main Test section, such as clearing workspace
variables, closing a file, or freeing system resources.

For more detailed information about the sections of the test, see “Working
with the Sections of a Test” on page 2-2.

The following figure illustrates the structure of a test in SystemTest.
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Test Structure

Pre Test
pre fest element ”
by
Main Test H main test variables
main test element I
ITERATIONS
test vectors

save results

Post Test

post test element "

Creating a Test Vector

Test vectors are composed of values derived from a MATLAB expression. You
can use any MATLAB expression that evaluates to a 1-by-N matrix or cell
array to define your test vector. Using test vectors, you can iterate through
a range of values to see how a system performs. Test vectors constitute
parameterized testing in SystemTest. They are the test cases for your test.

1-13
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For tests with multiple test vectors, the product of the lengths of the test
vectors defines the number of iterations the test performs. For example, if you
define the test vector [10 20 30], the test runs three times, using a value

of 10 for the first run, 20 for the second, and 30 for the final run. If you add

a second test vector with three other values, the total number of test runs
would be nine. SystemTest iterates through each vector in combination with
the other vector as though the test were a group of nested FOR loops—the
outermost loop being the first test vector in your table and the innermost loop
being the last test vector. The Main Test section in the Test Browser shows
the total number of test iterations defined by your test vectors.

For the example, use the vector [pi/15:pi/15:4*pi] which defines 60 values
for our test vector ranging from pi/15 to 4*pi in pi/15 increments. To specify

this test vector in SystemTest:

1 Click the New button in the Test Vectors pane.

The Insert Test Vector dialog box opens.
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Insert Test ¥Yector x|

Mame:
ITestVectnrl

Expression { exarmple 1:10, of rand(1,25) )
ft:1:10

Weckaor

|[123456?‘8910]

Murmber of iterations

IlD

Erouping

{* Ungrouped - This test vector will be permuted with
other test vectors in every possible combination,

" Grouped - This test vectar will be combined sequentially
with all grouped test vectors, and then permuted with
all ungrouped test vectors in every possible
combination.

Far example, the following kest vectors would produce a
combination of {1,3,5), (1,4,8), {2,3,5), (2,4,6) when the
kest is run:

Ungroupediector [1 2]

Groupedvectorl  [3 4]

Groupedvectar2  [S 6]

(0] | Cancel |

2 Assign a name to the test vector by clicking the Name field. For this
example, name the test vector signal.

3 Assign a value to the test vector by clicking the Expression field. Enter
the test vector specified above for the pi values. Click OK.
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Tesk Vectors LAl Test Variables
‘ New...” Edi... ‘ + | g* |

MNarne Expression eckor Iterations | Grouped
signal [pif15:pif15:4%pi] |<1x60 double = a0 [

Total number of iterations: 60

After you create the test vector, in the Test Browser pane, the Main Test
section label updates to include the number of iterations defined by the test
vector. It should say Main Test (60 Iterations).

Grouping Test Vectors

Note that the vector you just created is an ungrouped vector, which is

the default. You can also create grouped vectors, in order to affect the

way iterations are run. By grouping test vectors, they will be indexed
simultaneously with the other grouped vectors. Each set of grouped values are
then permuted with all the ungrouped test vectors. This gives more control
over the flow of tests and is useful for Monte Carlo or Design of Experiments
(DOE) based testing as well as defining signal groups, similar to those defined
in the Simulink Signal Builder block.

For example, if you are testing a throttle body controller, you may want to
sweep across a range of input level or a gain values, while simultaneously
selecting different throttle body types, each defined by their mass and
damping characteristics.
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An example of the vectors in this scenario could look like this:

gain = [1 10 100]
mass [a b c d]
damping = [w x y Zz]

If the gain vector is ungrouped, and the mass and damping vectors are
grouped, it will result in mass and damping being indexed simultaneously for
each value of gain. The test runs would look like this:

Run 1: (1, a, w)
Run 2: (1, b, x)
Run 3: (1, c, vy)
Run 4: (1, d, z)
Run 5: (10, a, w)
Run 6: (10, b, x)
Run 7: (10, c, V)
Run 8: (10, d, 2z)

. )
Run 9: (100, a, w)
Run 10: (100, b, x
Run 11: (100, c, vy)
Run 12: (100, d, z

Note Grouped test vectors must be the same length.

Defining Test Variables

SystemTest uses test variables to define temporary storage variables that a
test acts on or generates. You assign test variables in the Pre Test or Main
Test sections of your test.

You can define Pre Test variables or Main Test variables. Using Pre Test
variables, you can assign an initial value to a test variable that persists
between Main Test section iterations (unless another element in Main Test
modifies the value). Pre Test is not mandatory, but it can be used if your test
requires set-up operations to be performed.

Main Test defines the test elements that need to be performed across the
parameter space defined by your test vectors. Main Test variables are

1-17
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initialized before each Main Test iteration, which allows you to assign an
initial value to a test variable each time the Main Test runs. This is useful if
your test variable has a derived value such as being indexed by a test vector
or is the result of a MATLAB expression. You add elements in this section.

The example test requires three test variables:
e Y — Contains a value that will be calculated from the signal test vector

at each iteration.

® HiLimit — Contains the upper limit for Y that you do not want the signal
to exceed.

e |LowLimit — Contains the lower limit for Y that you do not want the signal
to go below.

To create these test variables in SystemTest:

1 Click the Test Variables tab at the bottom of the SystemTest desktop
to access the Test Variables pane.

2 Click the New button to create a Pre Test or Main Test variable. The Insert
Test Variable dialog box opens. Leave the default value of Main Test in the
Assigned in field, to create a new Main Test variable.

Insert Test ¥ariable |

Marne:
I\-'arl

Initial value {optional)

Assigned in

IMain Test LI
(0] 4 | Cancel |

3 Assign a name to the test variable by clicking the Name field and entering
the test variable name. For this example, enter Y.

1-18
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4 Set the test variable’s initial value by clicking the Initial Value field and
entering a value. For the example test variable Y, enter 0. Click OK.

Note If you do not provide an initial value, it will default to empty, that is

Vari = []; in MATLAB code.

Test Vectors

Test Variables

| Mew, .. | Edit... | 4+ 3 ‘ g* |

A X

Marne

Initial Walue

Assigned In

H ]

Main Test

5 Repeat steps 2 through 4 to create the remaining two test variables, using
the settings listed in the following table:

Variable Name

Initial Value

Assign in

HilLimit

LowLimit

:
-1

Main Test
Main Test

Adding Elements

Elements are the actions that a test performs. SystemTest includes the
following set of elements, listed in alphabetical order.
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¢ [F — Implements a logic control operator

¢ Limit Check — Specifies the comparison to be performed of the value(s)
under test and their expected value(s), or limit(s)

e MATLAB — Executes any MATLAB statements

® Scalar Plot — Graphically shows the value of any test variable or vector, as
the test is executing, as a scalar plot

¢ Simulink — Runs a Simulink model. Note that you need to have a license
for Simulink to use this element.

¢ Stop — Implements a logic control operator

® Subsection — Creates a new section in a test that you can use to group
elements within

® Vector Plot — Graphically shows the value of any test variable or vector, as
the test is executing, as a vector plot

Note Some MathWorks products, such as Image Acquisition Toolbox, Data
Acquisition Toolbox, and Instrument Control Toolbox, provide their own
elements that integrate those products’ capabilities within SystemTest. If
you have licenses for those products, those elements will also appear in the
elements list.

For more information about using the basic elements, see Chapter 2, “Working
with the Basic Elements”.

You add elements to a section in your test; however, not all elements can be
added to all sections. For example, you can use a MATLAB element anywhere
within a test, but you can only use the Limit Check element in the Main
Test section.
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To illustrate using elements, let’s continue with our example. This test uses
three elements in the Main Test section:

Element
MATLAB

Limit Check

Scalar Plot

Description

Use a MATLAB expression to assign data to Y that is
dependent on the test vector signal.

Compare the value generated in the MATLAB element to
the specified limit and see if the Y test variable exceeds
the upper or lower limit you defined in your HiLimit and
LowLimit test variables.

Plot the current test variable values and see whether the
test variable exceeds the upper and lower limits.
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To add these elements in SystemTest:

1 Select the section of the test in which you want to add the element. For this
example, click Main Test in the Test Browser.

| Test Browser A X

t & | x|

| Mew Test Element +

[=-Untitled
----- Pre Test

..5ave Results
“...Post Test

2 Specify the element you want to add to the test section. For this example,
click the New Test Element button and select MATLAB. SystemTest
adds a MATLAB element to the Main Test section of your test and opens
the MATLAB element property page in the Properties pane of the
SystemTest desktop.
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| Tesk Browser

| Mew Test Element ~

L 4 Properties - MATLAB

t 3 | X | MATLAB Scripk

El-Untitled

g\-----P|:|st Test

. T

%% MATLAE Element
Executes MATLAE code during Pre Test, Main Test, or Post Test.

E

MATLAE wariables declared here can be accessed throughout
a test by creating 3ystemTest test wvariables as follows:
1) Select the Insert mwenu option "Test Variable. .. ™
2) Configure the name Lo watch the MATLAE wvarisbhle's nsume

o =1 hon e )
B

R O i T &

P 4 B ot s on 7 g e g e T L

3 In the Properties pane, type the following M-code in the MATLAB Script
edit box. This MATLAB code calculates a value for Y that is dependent
on the test vector signal.

Y = sin(signal)+ rand -.5;

| Proper MAT

MATLAE Script

Ak

o

MATLAE wariables declared here can be accessed throughout
a test by creating 3ystemTest test wvariables as follows:

w

1] Zelect the Insert mwehu option "Test Variasble...'™
21 Configure the nawme to match the MATLAE wvariasble's name|

o

% MATLAE Elemment (
Executes MATLAE code during Pre Test, Main Test, or Post Test.
{

Wood -1 o n s L D
s

¥ = z2in(=ighal)+ rand -.5;

/
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During each iteration, SystemTest evaluates the MATLAB expression and
assigns a value to V.

Add the Limit Check element to the Main Test section of the test. With
the MATLAB element selected, click the New Test Element button, and
click Limit Check. SystemTest adds a Limit Check element to the Main
Test section of the test and opens the Limit Check properties page in the
Properties pane. For this example, the Limit Check element must follow
the MATLAB element in the test.

Note You can reposition an element in a test by selecting the element
and then clicking the up and down arrows in the Test Browser toolbar.
You can also drag and drop elements within Main Test. You cannot move
elements between test sections.
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| Test Browser A X

t 3| x|

| Mew Test Element -

[=-Untitled
= ----- Pre Test
E| Main Test (60 Iterations)
o B maTLae

Limit Check

-5aye Results

L.Post Test
Test Vectors Test Variables 2 x |
| Mew, . ‘ Edit, . | + 3 | g ‘

Mame Initial walue Assigned In
v i Main Test
3 Hicimie |1 Main Test
FB Lowtimit |1 Main Test

Properties - Limit Check

—Conditions

General Check I Tolerance Chack |

[t | # $ |0

Test Yariable I Operatar

Lirnit:

For this element to pass:

I Al roves must evaluate to true (logical AMD)

If this element fails:

I Current iteration continues

Assign data ko

In the General Check tab, click the New button to add a limit check.
Notice that the Limit Check element icon in the Test Browser shows

a red x, which indicates that information is missing. The corresponding
red outlining in the Properties pane highlights any fields that require
configuration. A test cannot run unless everything is properly configured.
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5 Specify the limit comparison operations in the Limit Check element.

a In the Test Variable column, click the drop-down list and select a test
variable you created in step 4. For this example, select Y.

b In the Operator column, click the drop-down list and select
the comparison you want to perform. For this example, pick the
less-than-or-equal-to operator, <=.

¢ In the Limit column, click the drop-down list and select the test variable
you want to compare to. For this example, select HiLimit, which is the
test variable you created earlier.

The following figure shows the configuration of this limit:

| Properties - Limit Check

~Conditions é
General Check | Tolerance Checkl )
[ new | & 8|5 ,
Test Wariable Cperator Limnit

¥ =] <= = | Hiimit ~|

S - '..- -t ,— ", ’-p' . . _f _f,]

6 To add another limit comparison operation, click the New button again in
the General Check Properties pane. SystemTest adds a new row below
the last limit you specified. In this new row, set Test Variable to Y, set
Operator to >=, and set Limit to LowLimit.
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The following figure shows the configuration of this second limit:

| Properties - Limit Check

For each iteration of the Main Test, the MATLAB element’s expression is
evaluated and a new value assigned to Y. When the Limit Check element
runs, it determines whether the value of Y falls between the HiLimit and
LowLimit values. If Y is outside this range, the test iteration fails. The
default pass/fail criteria for the overall test passes the test only if both

—Conditions

General Check. | Tolerance Checkl

e [ B

Test Variable Cperator Lirnit
v he <= || HiLimit hd
Y ~| >= | LowLimit |

¥ v o "

e

expressions in the limit check evaluate to true.

7 To view the test variables as the test runs, plot the data. To add a Plot
element to the test, click the New Test Element button, and select Scalar
Plot. SystemTest adds a Scalar Plot element to the Main Test section, and
opens the properties page for the element in the Properties pane.

- F

Tl T
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| Test Browser X Properties - Scalar Plot A X

t 3| x|

~-Saye Results
“Post Test

‘ Mew Test Element ~ e
[El-Untitled
> ----- Pre Test f\/‘\/ ot )
[=-Main Test (60 Iterations)
] maTLae
Limit Check, % Acis
I Iteration Mumber LI

Mazimum Murmber of Points ko Display at Once
IInF

~Lines ta Plak
[t | # B |7
i Bxis Line Calar Line Skyle Line Market

* | <autox ll Solid LI o Marker LI

With each Main Test iteration of the test, the Scalar Plot element updates a
figure window with data you selected.

8 Click the New button twice in the Properties pane and set the three
rows to match the following table:

Y Axis Line Color Line Style Line Marker
Y Blue Solid Point
HiLimit Red Dashed No Marker
LowLimit Black Dashed No Marker
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| Properties - Scalar Plot A X
Flok Type
* Bxis
I Iteration Mumber LI

Maximum Mumber of Points to Display at Once
IInF

~Lines ko Plak
[hew | & & | 3|
i Bis Line Colar Line Style Line Marker

¥ || Biue || soid | Point
HiLirit L‘ Red L‘ Dashed Ll Mo Marksr
LowLirnit L‘ Black. L‘ Dashed Ll Mo Marker

KN EN KR

Defining Pass/Fail Criteria

You can define whether your test passes or fails by making SystemTest
monitor the outcome of any or all Limit Check elements during any or all
Main Test iterations. Your test’s threshold of success can range from the
passing of any Limit Check in any single test iteration to the passing of all
Limit Check elements in all test iterations. If your test contains no Limit
Check elements, there is no notion of pass/fail and no pass/fail information is
displayed. (Testing of this type is useful for experimenting with a system or to
explore its behavior rather than validate its performance.)

You can set any of the following conditions to define when your test passes:

e All Limit Check elements pass in all test iterations.
e All Limit Check elements pass in any test iteration.
¢ Any Limit Check element passes in all test iterations.

¢ Any Limit Check element passes in any test iteration.
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You can configure this behavior within the test’s Properties pane. Click the

test name in the Test Browser (named Untitled by default) to open the
test’s properties and look for the section labeled This Test Passes If.

Using the signal test example that you constructed in this section, set the test

to pass if all Limit Check elements pass in all test iterations.

Test Browser 4|l [Properties - Untitled 7
| Neve Test Elsment - t ; | X | ~Test Results Save Options
= Untitled |c:imaTLABYNEIed_results.mat s |
--Pre Test
E---Main Test {60 Iterations) {* Owerwrite test results
-] maTLAB ™ Create new numbered test results {ex: Resulks{1).mat)
Limit Check.
Scalar Plat ~This Test Passes IF
ave Results

..... Post Test % &l limit check elements in an iteration pass

= Any limit check element in an iterakion passes
AND

% Alliterations pass

" Any iteration passes

After the Test Runs

¥ wisualize and plat saved results by launching the Test Resuls Yiswer

[¥ Generate a report of the test execution

Tesk Description

Saving Test Results

SystemTest saves the results from the iterations of your test in a MAT-file. You
must explicitly specify which test variables you want to save as test results.

SystemTest gives you the ability to save results at the end of each iteration.
Before you run your test, select the Save Results section in your test and
specify which test variables you want to save as test results. Click the New
Mapping button and then select from the drop-down list the name of the test
variable you want to map to a result. You can optionally specify a name for
the results that you want to save. By default, the name of the saved result
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will be the same as the test vector or test variable. The following figure shows
the mapping of test variables to test results:

E---Main Test {60 Iterations)
i P MaTLAE with saved test results,

Test Browser A X | Properties - Save Results A X

| Hew Test Elerment ~ [ 4 4 | » | ~MMap Test Wariables ta Results

=1-Untitled Specify the test variables you want to save at the end of each Main Test iteration by
iPre Test mapping a kest variable to a test result name.

Moke, kest vectors do not need ko be specified, By default, they are made awailable

] Limit. Check
[+*+] Scalar Plot Mew Mapping | +t 3 | E |

~3ave Results Test Variable Result

- Post Teskt ¥ .

-
HiLimit ¥ || HiLimit
-

LawLimit LaowLimit

After you specify which test variables you want to save as test results, you
can specify the name of the MAT-file that SystemTest uses. Using this
MAT-file you can reload the test results into the base workspace. By default,
SystemTest names the file Untitled results.mat and puts the file in the
current working directory (visible in the SystemTest toolbar). To change the
name or location of the MAT-file, click on the test name in the Test Browser,
then in the Properties pane, use the Test Results Save Options field.

By default, each time you run the test you overwrite this file unless you select
the Create new numbered test results option on the test Properties pane.

Note Test variables that are not saved as a test result will be lost at the end
of the test execution.

Test Report

When you run your test, SystemTest displays the status of the test in the Run
Status pane. This display contains basic information about your test:

* Time elapsed since your test started running.
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® Which section your test is in.

* How many test iterations have passed or failed as defined by any limit
checks.

® Whether your test completed successfully.

® Any errors that cause your test to stop.

You can make SystemTest generate and save more detail about the running
test by enabling the Test Report, which is a test execution log file in html
format. This report is especially useful when you use limit checks in your
test and you want to see specific test iterations that passed or failed. For
example, instead of just finding that a test iteration failed, the report helps
you determine how far a test variable varied from the upper or lower limit
defined in a Limit Check element. This report is also useful for documenting
and sharing your test results.

To enable the Test Report, check the Generate a report of the test
execution option on the Test Properties pane.

The Test Report contains the following information about the test run,
organized by iteration in the report:
® The test description, if you entered one in the Properties pane of the test.

® A test summary, including start and stop times, number of iterations
completed, number of iterations that passed and failed, and final status
of the test.

¢ Pass/fail results of Limit Check elements, by iteration.

¢ Values for any saved results you captured by setting up mappings in Saved
Results, by iteration.

¢ Test vector values, by iteration.
® A snapshot of your model if you use a Simulink element in the test.

* A snapshot of your plot if you use a Vector Plot or Scalar Plot element in
your test, by iteration.

* A summary of generated files, with links to them. These can include a
Simulink model coverage report and the test results launched in the Test
Results Viewer.
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Note Because SystemTest generates the Test Report while the test is
running, this option results in the test taking longer to execute.

The report file is located in a subdirectory of the folder where you have
chosen to store your test results MAT-file. The subdirectory will be named
<testname>_report, where testname is the name of the active test. The Test
Report will be stored in this directory, along with all dependent files, such as
plot or Simulink model snapshots. The overwrite options you set for your test
results MAT-file also apply to the file name and directory of your report file.
See “Saving Test Results” on page 1-30 to learn how to change these options.

See “Viewing the Test Report” on page 1-37 to see what information the
report generates.

Saving Your Test

SystemTest lets you save tests so that you can reuse them later. For example,
to save the signal test:

1 Select File > Save As to open the Save file as dialog box.
2 Select a directory location and enter mySavedTest in the File name field.

3 Click Save.

SystemTest saves the test as mySavedTest.test and renames your test as it
appears in the Test Browser. This does not rename the test results MAT-file
or the Test Report file. Their names are controlled separately from the name
of the test, as explained in “Saving Test Results” on page 1-30.

Running Your Test

After you build a test, you are ready to run it. At run time, SystemTest
assigns values to test vectors and test variables in the order they appear in
the Test Vectors and Test Variables panes. Each test section runs elements
in the order that they appear in the Test Browser.
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To execute your test, do one of the following:

® (Click the Run button.
e Select the Run > Run menu.

® Press the F5 key.

+} SystemTest - Untit

File !—Run Tools  Deskl

.E:} Run F5
Stop k-
(e | SERh S

Note While a test is running, you can stop its execution by pressing Ctrl+C
or clicking the Stop button on the toolbar.

Tracking Output

While the test runs, the Run Status pane shows summary test output,
including start and stop times, number of iterations completed, number of
iterations that passed and failed, and final status of the test. It will also
display any error messages if the test has an error.
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Getting Started | Desktop Help

Generated Files

Type Location

Test

COAMATLABYWSImple_Demo_Getting_Started. mat
Results

Test

Report CAMATLABNSImple_Demo_Getting_Started_report\Simple_Dermo_Getting_S

Final Test Status

Property Value

Start Time 04-Jan-2007 10:09:28
Stop Time 04-Jan-2007 10:039:46
lterations

Completed el

lterations Passed 43
lterations Failed 17
Final Status Failed

Tesk Status: Failed
Time Elapsed:  00:00:17

e

If your test includes a Plot element, SystemTest creates the plot and updates
the plot during each iteration. Since Limit Check elements evaluate whether
an iteration passed or failed, they directly affect the data that appears in the
Test Report and the Run Status pane.

In the example test, the plot includes the high and low limits defined in the
Limit Check element, to show which test iterations exceed the limits.
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[T - ) Plots - Simple_Demo_Getting_Started: Scalar Plot: 04-Jan-2007 10:09:29 2 X

DS KRaN® €| 0B|e0 BOEFO = x

05

10 20 30 40 a0 B0
lteration Mumhber

When the test is done running, the Run Status pane provides links to
generated output. The Generated Files section contains a summary of
generated files, with links to them. These can include the Test Report; the test
results, opened in the Test Results Viewer; and a Simulink model coverage
report, if your test uses the model coverage feature.
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Analyzing Your Test Results

After SystemTest runs your test, you can explore the results that SystemTest
generated. This section shows how to:

¢ View and interpret the Test Report.

® Inspect your test results with the Test Results Viewer.

Viewing the Test Report

When you enable the Test Report, SystemTest saves information about
each test iteration in an HTML file. To enable the Test Report, check the
Generate a report of the test execution option on the Properties pane
before running your test. The report contains summary information about
the test run, snapshots of any plots you used, snapshots of any models you
used, pass/fail results of Limit Check elements, and other information. See
Test Report for a full description of what the report contains.
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After a test runs, you can see the contents of this file by clicking the Test
Report button on the SystemTest toolbar or using the View Test Report
link in the Run Status pane. The generated output resembles the following:

/MATLAB,/Simple_Demo_Getting_Started_report;/Simple_Demo_Getting_Started reporthtml - | Ellil
File Edit View Go Debug Deskiop Window Help u
= =p c | @ | h | Location: Ifile:,I',I',I’C:,I'MATL.C\B,I'SimpIe_Demo_Getting_Started_report,l'SimpIe_Demo_Getting_Started_report.html LI
Simple_Demo_Getting_Started :!
Pre Test
Iteration 1
Test Vectors
signal 020944
Limit Check
Test Variable Operator Limit Evaluates To
A _ HiLirnit
0.65604 = 1 TRUE
Y _ LoweLimit
065804 >= 1 TRUE
Scalar Plot
1
0.a
*
0.6
4| | _’l_l
Dane v
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The Main Test section of the report shows each iteration. You see the value of
the test vector signal and determine the values the Limit Check element used
in evaluating whether the test passed. For the first several iterations, the
value of Y did not exceed either the high or low limits so the iterations passed.
You can also see this in the scalar plot drawn while the test ran. For other
iterations that failed, you can scroll through the report to find the values of Y.

Viewing Test Results in the Test Results Viewer

To help you analyze your test results, SystemTest includes a tool, called the
Test Results Viewer, that provides a variety of plotting tools and the ability to
compare data. With this tool, you can see how your test results compare to the
test vectors used as inputs to your test.

You can start the Test Results Viewer by selecting it from the Tools menu.
You can also configure a test to launch the Test Results Viewer automatically
when the test completes. To do this, select the test in the Test Browser
and select the Visualize and plot saved results by launching the Test
Results Viewer option on the test’s Properties pane.

The test vectors in your test and the test results you selected to be saved
appear within the viewer so you can immediately start to explore your data.
For any selected test vector or test result, you can see a summary of statistics
for its values in the Data pane. For example, after running the test, the
viewer opens showing the saved test results and signal test vector. Clicking
the Y test result shows information such as the highest and lowest values that
Y evaluated to during the test. It also shows the mean, median, and standard
deviation for all values.
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) Test Results Yiewer -
File Edit

P[] ] e L
Data A X

@ B

* Rezults |

C: Temp'Untitled_results.mat
Tools

Yiew  Inserk Constraints  Resulks  Plots Desktop  Window  Help

) Plots - A X

Mame £

| Walue

Type

W
HiL irnit
LovaLimit

=11 double=  Raw scalar
=1x1 double=  Raw scalar
=1x1 double=  Raw scalar

w Test Vectors

Mame £

Walue

sighal

=R0x1 doub...

Step 1. Explore your data and
create constraints to view subsets.
Plot it using the toolbar buttons:

Gile Edt Yiew [nsent Tools

w Data Statistics: ¥ £ Refresh| ||E| L Ly
Statistic Unconstrained Constrained

e 1.34 1.34 -

in 144 1.44 J

hiean 00122 00122

heclian 0.0581 0.0581 x|

Constraints A ox

= Tt ¥
§ I - l I 4

|_S|gnal == w| 03 Define Plot 7 x

0209 1
1 | 2

[ 00 erations

[~ Flat single terstion at & time

I

The viewer has a rich selection of plotting capabilities that you can use to
visualize your test results. Plotting capabilities include line, scatter, time
series, surf, waterfall, and image plots. Using the signal example, you can
reproduce the line plot that your scalar plot element generated during the test.

1 Click the Line Plot button.
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« ): Test Results Yiewer - C:h\Ten
File Edit Wiew Insert Tools o

Dl

Line Plak

2 In the Define Plot pane, click the X Axis list and select signal. Note that
you should choose signal or Auto values for the X-axis if you want to show
test vectors; line plots that use the X-axis for test vectors let you see how
each test iteration value corresponds to a test result.

3 Click the Y Axis list and select Y.

4 Click the Plot button.
You now have a line plot that resembles the scalar plot.

Line Plot: ¥ vs. signal
15 T T T T T T

0ar E

05 -

signal

You can make this plot show the HiLimit and LowLimit test results too.
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1 In the Define Plot pane, click the Multiple Y Data option. The Y Axis
field expands to show all saved test results from your test.

2 Select the check boxes next to HiLimit and LowLimit.

3 Click the Refresh Plot button.

Constraining Data for Further Analysis

Using the Test Results Viewer constraint capability, you can filter out data.

For example to see only the test iterations that passed the test, you can create
two constraints that screen out data that exceeds the upper and lower limits.

Note By default, the Test Results Viewer provides a list of test vector
constraints for you to choose from.

To create and configure the constraints:

1 Click the New Constraint button in the Constraints pane.

Constraints a X

= DD+ &5

New constraint button

The Add a New Constraint dialog box appears.

2 Click the Using a result or test vector option button.

3 Select Y from the list.
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«): Add a New Constraink x|

% Using & result or test vector
K =
(" Uzing & MATLAE expression

Example: var2=3.0

8],4 Cancel

4 Click OK. A new constraint appears in the Constraints pane.

5 Create another constraint by repeating steps 1 to 4.

6 Click the check box next to the first constraint to activate it.

7 Make sure the operator is set to >=.

8 Click the constraint’s text field and change the constraint to -1.

9 Click the check box next to the second constraint to activate it.
10 Click the operator and set it to <=.

11 Click the constraint’s text field and change the constraint’s value to 1.

The green indicator bar beneath the constraints shows how many iterations
remain following the filter you applied. This is also reflected in the line plot,
which the viewer redraws after you apply the new constraints. As you can
see, only a subset of your test result remains.
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Line Plot: Multiple variables vs. signal
1 T T T T T T

0t & .

06 - ' .
0.4} .

02 1

Multiple

02t .
04t .
06 .

a8t : -

signal

You can just as easily show only the iterations of your test that failed by
reconfiguring the constraints you created to filter out data that is < -1 or
> 1. Alternatively, you can create a new constraint that uses a MATLAB
expression. For example:

1 Delete the constraints you just created.
a Select the constraint row.

b Click the Delete button.

2 Click the New Constraint button in the Constraints pane. The Add a
New Constraint dialog box appears.

3 Click the Using a MATLAB expression option button.
4 Enter the expression Y<-1||Y>1.
5 Click OK.

6 Select the check box next to the constraint.

The Test Results Viewer redraws the line plot to now show only those test
iterations that failed.
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For more information about the Test Results Viewer, see Chapter 7, “Using
the Test Results Viewer”.

Saving Your Test Results

You can save the plotting and analysis work done in the Test Results Viewer.
Data, constraints, and plots created in the Test Results Viewer can be saved
and then reloaded in order to continue working on or viewing the data, or to
share it with others.

To save your test results and the state of the Test Results Viewer, use the File
> Save Test Results or File > Save Test Results As commands from the

Test Results Viewer desktop.

For more information on what is saved and on how to reload your saved files,
see “Saving and Reloading Test Results” on page 7-38.
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Working with the Basic
Elements

Working with the Sections of a Test Describes the three sections of the
(p. 2-2) test and which elements you can add
to each one

Basic Elements (p. 2-4) Describes the basic elements, which
sections of the test you can add them
to, how they work, and their options
in the Properties pane



2 Working with the Basic Elements

Working with the Sections of a Test

Each section of the test serves a different purpose and has different properties
that can be set in the Properties pane. Click on a part of the test or an
element in the Test Browser to see the properties for that section or element.

The descriptions of the elements in this chapter include a list of which sections
of the test you can use each element in. The following sections describe the
sections of a test. They are followed by a description of how to use the basic
elements.

® “Pre Test” on page 2-2

e “Main Test” on page 2-3

® “Post Test” on page 2-3

Pre Test
The Pre Test runs once prior to any number of iterations through Main Test.

Pre Test can be used to perform general test setup such as:

® Opening a model.

¢ Initializing variables.

® Accessing system resources, such as opening a file.

¢ Initializing external test equipment.

In Pre Test, only test variables defined as a Pre Test variable may be modified

or assigned to. Pre Test variables are initialized during Pre Test and persist
throughout the Main Test and Post Test.

In Pre Test you can add the following element types: Simulink, MATLAB,
Subsection, Stop, IF, Video Input, the three Instrument Control Toolbox
elements, and the four Data Acquisition Toolbox elements.

With Pre Test you can initialize Pre Test variables and run elements that you
only want to run once before any Main Test iterations. For example, you can:

¢ Add a Simulink element to run a model and assign baseline data to a Pre
Test variable.
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e Add a MATLAB element to load a MAT-file or perform some other test
setup.

® Create conditions with the IF element and follow up with a Subsection
element to define what to do when those conditions are met.

Main Test

The Main Test is run one or more times based on the number of iterations.
It is used to:

¢ Execute elements multiple times in order to perform batch testing or sweep
through a parameter space.
¢ Perform batch testing or parameter sweeps that require multiple

independent iterations using different test conditions for each iteration.

The number of iterations is defined by the number and length of test vectors
you specify. SystemTest executes Main Test once for each permutation of
values in the test vectors specified.

In Main Test you can add all of the element types.

Post Test

The Post test runs once after all Main Test iterations have executed or when
a run-time error occurs in Pre Test or Main Test. Post Test can be used to
perform test cleanup, such as:

¢ (Closing a model.

¢ (Cleaning up your workspace.

® Releasing system resources, such as closing a file.

® Returning external test equipment to a safe state.

In Post Test you can add the following element types: MATLAB, Subsection,

IF, Video Input, the three Instrument Control Toolbox elements, and the four
Data Acquisition Toolbox elements.
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Basic Elements

The following sections describe how to work with the basic elements.

e “MATLAB Element” on page 2-4

¢ “Limit Check Element — General Check” on page 2-5

¢ “Limit Check Element — Tolerance Check” on page 2-9

¢ “IF Element” on page 2-12

* “Vector Plot Element” on page 2-13

e “Scalar Plot Element” on page 2-15

e “Stop Element” on page 2-17

® “Subsection Element” on page 2-18

The Simulink element is covered in detail in Chapter 3, “Using the Simulink
Element”. The hardware elements are covered in detail in Using the Image

Acquisition Toolbox Element, Using the Data Acquisition Toolbox Element,
and Using the Instrument Control Toolbox Element.

To see the MATLAB, Limit Check, and Scalar Plot elements used in an
example, see “Adding Elements” on page 1-19.

Note You can rename any element or subsection by double-clicking its name
in the Test Browser.

MATLAB Element

The MATLAB element lets you run MATLAB scripts from within a test.

In addition to specifying any valid MATLAB script to execute, you can
incorporate any test variable into your code, as well as access any variables
residing in the MATLAB workspace.

Allowed Test Sections
The MATLAB element can be used in the following test sections:



Basic Elements

® Pre Test
e Main Test
® Post Test
|Test Browser ; Properties - MATLAB A X
|NewTestElementv + 3 ‘ x | MATLAE Script
SR L % MATLAB Elemwent
""" Pre Test Executes MATLAE code during FPre Test, Main Test, or Post Test.
[E-Main Test

Lk

: —JMATLABI MATLAE wariables declared here can be accessed throughout
RReUEIRESUIES a test by creating 3ystemTest test varisbhles as follows:
~-Post Tesk

1) Zelect the Insert menu option "Test Variable...™
2] Configure the name Lo match the MATLAE wvarisble's name

W -1 M m e W
B L L o

Properties Pane
In the MATLAB Script edit field, enter any valid MATLAB script.

Limit Check Element — General Check

The General Check tab of the Limit Check element determines test
conditions are met by using scalar, vector, or matrix comparisons. It can be
used to:

®* Compare measured data to expected data.

® Stop an iteration or an entire test if a test constraint is violated.

® Assign a test variable the logical value derived from the comparison(s)

for use by other elements.

You can do the following types of comparisons with the General Check tab
of the Limit Check element:

2-5
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® Scalar vs scalar
® Scalar vs vector
® Vector vs vector

e Matrix vs matrix

Note Use the Tolerance Check tab of the Limit Check element to test
absolute and relative tolerance.

Allowed Test Sections
The Limit Check element can be used in the following test section:

e Main Test
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[Test Browser [ 4 Properties - Limit Check X

‘ Mew Test Element ~ | &+ & | x I
[=-Untitled
> ----- Pre Test General Check I Telerance Check |
I::EI---P"!ain Test | Mew ‘ + 3 ‘ X |
e Limit Check
! Test Yariable Operatar I Lirnit

= —— =1 =

Test Vectors [

asab¥ariables T30
‘ New... |Edit... ‘ +t 3 ‘ B |

MName I Initial Yalue I Assigned In I

For this element ko pass;

I All rows must evaluate to true (logical AMD) LI

If this element Fails:

I Current iteration continues - I

Assign data to:

| |

How to Use

1 Click the New button on the General Check tab to add a general limit
check.
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— Select an existing test variable or create a new one in the Test
Variable column.

— Select an operator in the Operator column.

— Select an existing test variable or test vector or create a new one in
the Limit column.

2 Set your test’s passing conditions.

— The element can pass if all comparisons complete successfully (a
logical AND).

— The element can pass if one or more of the comparisons complete
successfully (a logical OR).

3 Set your fallback procedure if the element fails. You can:

— Allow the current iteration to continue executing.
— Stop the current iteration and proceed to the next iteration.
— Stop the test and proceed to Post Test.

4 Identify the SystemTest test variable you want to assign the logical value
derived from the comparison(s) in the Assign data to field.

Note Aside from setting limit checks on individual elements, you can set
these properties for the entire test, reachable by clicking the test name in the
Test Browser, to determine pass/fail criteria for the test as a whole.

Properties Pane — General Check
You can set the following properties for the Limit Check element:

¢ Test Variable — Value to compare to limit using operator.
® Operator — Boolean operator used to compare test variable to limit.

¢ Limit — Value to compare to test variable using operator.

* For this element to pass — Choose between a logical AND (all
comparisons must pass) or a logical OR (at least one comparison needs to
pass) for the element to pass.
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¢ If this element fails — Choose between continuing the test, stopping the
current iteration, or stopping the entire test.

® Assign data to — Test variable assigned the logical value of this
evaluation. The logical value will be 1 if the element passes or 0 if the
element fails.

Limit Check Element — Tolerance Check
The Tolerance Check tab of the Limit Check element verifies test conditions

are met by using absolute and relative tolerance comparisons. It can be
used to:
® Compare measured data to expected data.

® Stop an iteration or an entire test if a test constraint is violated.

® Assign a test variable the logical value derived from the comparison(s)
for use by other elements.

® Define pass/fail criteria for an iteration.

You can do the following types of comparisons with the Tolerance Check tab
of the Limit Check element:

* Absolute tolerance

® Relative tolerance

For a definition of these tolerance types, see the Properties Pane section.

Note Use the General Check tab of the Limit Check element to test scalar,
vector, and matrix comparisons.

Allowed Test Sections
The Limit Check element can be used in the following test section:

e Main Test
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| Teskt Browser [l | Properties - Limit Check 2 X

| Mews Test Element = f ‘ ‘ 4 | S
[=-Untitled
iPre Test General Check  Tolerance Check I
E;{|---I"‘:Iain Test | Mew ‘ 1, ' ‘ ?( ‘
[ Limit Check
i i.Sayve Results Test Variable Expected Walue Tolerance Type I Tolerance Limik
L. Post Test J + | Absolute ﬂj -

Test vectors | Isstianiablesefudty
| Mew. . ‘ Ed... | Tt 3 | B |

Tarme I Initial walue I Assigned In I

For this element ko pass;

I All rows must evaluate to true (logical AND) d

If this element Fails:

I Current iteration continues i I

Assign data to:

| =l

How to Use

1 Click the New button on the Tolerance Check tab to add a tolerance
limit check.
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— Select an existing test variable or create a new one in the Test
Variable column.

— Select an existing test variable or test vector or create a new one in the
Expected Value column.

— Select Absolute or Relative in the Tolerance Type column.

— Select an existing test variable or test vector or create a new one in the
Tolerance Limit column.

2 Set your test’s passing conditions.

— The element can pass if all comparisons complete successfully (a
logical AND).

— The element can pass if one or more of the comparisons complete
successfully (a logical OR).

3 Set your fallback procedure if the element fails. You can:

— Allow the current iteration to continue executing.
— Stop the current iteration and proceed to the next iteration.
— Stop the test and proceed to Post Test.

4 Identify the SystemTest test variable you want to assign the logical value
derived from the comparison(s) in the Assign data to field.

Note Aside from setting limit checks on individual elements, you can set
these properties for the entire test, reachable by clicking the test name in the
Test Browser, to determine pass/fail criteria for the test as a whole.

Properties Pane — Tolerance Check
You can set the following properties for the Limit Check element.

¢ Test Variable — Variable to compare with expected value using a
tolerance limit.

¢ Expected Value — Expected value to compare variable to using a
tolerance limit.

¢ Tolerance Type — Tolerance type used to compare test variable to
the expected value. Select Absolute or Relative. Absolute tolerance is
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calculated using this formula: abs(test variable - expected value)
<= tolerance limit. Relative tolerance is calculated using this formula:
abs(test variable - expected value) <= tolerance limit.*
abs(expected value).

¢ Tolerance Limit — Value used as the tolerance constraint to compare
variable and expected value.

* For this element to pass — Choose between a logical AND (all
comparisons must pass) or a logical OR (at least one comparison needs to
pass) for the element to pass.

¢ If this element fails — Choose between continuing the test, stopping the
current iteration, or stopping the entire test.

* Assign data to: — Test variable assigned the logical value of this
evaluation. The logical value will be 1 if the element passes or 0 if the
element fails.

IF Element
The IF element provides logical control of a test by evaluating a condition.

The IF element allows sub-elements to run only when the IF element’s
condition evaluates to true. After adding an IF element, you should add one
or more elements to perform a specific task.
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Allowed Test Sections
The IF element can be used in the following test sections:

® Pre Test
¢ Main Test
® Post Test
|Test Broweer Properties - IF P x
|NewTestElementv + 3 | X ‘ Condition
E-Untitled Fals=
-Pre Test
[=-Main Test
. galF
. “-Save Results
------ Post Test

Properties Pane
You can set the following property for the IF element.

* Condition — Enter a valid MATLAB expression that will evaluate to
true or false.

Vector Plot Element

The Vector Plot element is used to plot array or vector data over multiple
iterations.

Use this element during the Main Test to generate plots of any test
variables containing array or vector data. You can change the number of
iterations displayed to as many as 16 (in a 4-by-4 matrix) using the Subplot
Dimensions fields. The default is one iteration.
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| Test Browser

‘ Mews Tesk Element =

T 3| x|

Allowed Test Sections
The Vector Plot element can be used in the following test section:

e Main Test

A

=-Untitled

----- Pre Test

E| Main Test

P Weckor Plot
: Save Results
o Post Test

Test Vectors

| New... | Edb |

sabatiatinhles T2
Y

Mame

I Initial Walue I Assigned In I

Properties - Vector Plokt

Flat Type

"/ \

® Bxis

plot

| <hane:>

rLines ko Plok

|t 8|

Y s

Line Color

Line Style Line Marker

« § =aukos

[

Solid

[

Mo Marker

[

~3ubplok Dimensions

Rows

1

[

Columns

1 =]

¥ Clear axes between iterations
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Plot Type
Choose one of the following plot types:

¢ plot — Standard plot of X and Y.

¢ semilogx — Semilogarithmic plot with logarithmic X-axis.

semilogy — Semilogarithmic plot with logarithmic Y-axis.

loglog — Log-log scale plot.

* stem — Lines extending from a baseline along the X-axis.

Properties Pane

You can set the following properties for the Vector Plot element.
e X Axis — Choose a test variable to use for an X-axis value.

® Y Axis — Choose a test variable to use for a Y-axis value.

¢ Line Color — Select a color to use for the line between each data point.

Line Style — Set the type of line to be drawn between each data point.

Line Marker — Choose a symbol to represent each data point.
Subplot Dimensions

® Rows — The number of rows you want displayed in the Subplots window.

¢ Columns — The number of columns you want displayed in the Subplots
window.

¢ Clear axes between iterations — Applies only when you have one row
and one column to display. Selecting this option (default) rewrites the plot
with new data during each iteration. Clearing this option adds new data to
the plot during each iteration.

Scalar Plot Element
The Scalar Plot element is used to plot scalar data for each iteration.

Use this element during the Main Test to generate a plot of one or more
scalar test variables.
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| Test Browser

Allowed Test Sections

The Scalar Plot element can be used in the following test section:

e Main Test

Properties - Scalar Plot

Flat Type

‘ Mew Test Element = | 0+ & | X ‘
=-Untitled
----- Pre Test
E---Main Test
Scalar Plok
------ Save Results

= Post Test

* Bxis

f\/’\\/ plot

I Iteration Mumber

Maximum Mumber of Poinks to Display at Once

IInF
rLines ko Flot
[tew | & | B |
¥ Axis Line Colar Line Style Line Marker
<auto LI Solid LI Mo Marker LI

Test Vectors

‘ New... |Edit... ‘ :.‘ 3 ‘ B |

Marne I Initial Yalue I Assigned In I

Plot Type

Choose one of the following plot types:

¢ plot — Standard plot of X and Y.

¢ semilogx — Semilogarithmic plot with logarithmic X-axis.

loglog — Log-log scale plot.

semilogy — Semilogarithmic plot with logarithmic Y-axis.
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* stem — Lines extending from a baseline along the X-axis.

Properties Pane
You can set the following properties for the Scalar Plot element.

¢ Maximum Number of Points to Display at Once — Determine how
many points to show simultaneously. By default this is infinite such that
all points will be plotted. Use a MATLAB numeric that evaluates to a
positive, nonzero integer to set this field’s value.

¢ X Axis — Choose a test variable to use for an X-axis value.

® Y Axis — Choose a test variable to use for a Y-axis value.

¢ Line Color — Select a color to use for the line between each data point.
¢ Line Style — Set the type of line to be drawn between each data point.

¢ Line Marker — Choose a symbol to represent each data point.

Stop Element

The Stop element stops an iteration or an entire test unconditionally.

You can use the Stop element with conditional logic elements, such as the IF
element, to control the test’s execution.

Allowed Test Sections
The Stop element can be used in the following test sections:

e Pre Test
e Main Test

2-17



2 Working with the Basic Elements

2-18

| Test Browser

A X Properties - Stop E 4

‘-Post Test

‘ New Test Element - | #+ & | X ‘ Wwhen this element runs
EI---Ulntitled I All testing skops LI
~Pre Test
I:EEI---Main Test Display Message
9 Stop I
-5ave Results

Properties Pane
You can set the following properties for the Stop element.

¢ When this element runs — Select a stop action for use in Main Test. The
Current iteration stops option stops the current Main Test iteration. The
All testing stops option stops all Main Test iterations and runs Post Test.

Note that when a Stop element is used in Pre Test, All testing stops is the
only option, since Pre Test does not have iterations.

¢ Display Message — Enter a message to display in the Test Report.

Subsection Element

Use subsection elements to organize one or more elements to maintain
readability of your test or to better manage complex test structures. Use
a subsection to:

¢ Group elements under a single root element.

¢ QOrganize tests.

e Manage complex test structures.
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Allowed Test Sections

The Subsection element can be used in the following test sections:

® Pre Test
¢ Main Test
® Post Test
| Test Browser A X Properties - Subsection A X
| il T AeviE = t " ‘ X | Tesk Description
[=l-Untitled %= Enker a description of the subsection here.
----- Pre Test
E:{l---Main Teskt

----- ?;g Subsection
‘ ‘..S5ave Results
‘. Post Test

Properties Pane

You can set the following properties for the Subsection element.

¢ Test Description — Type in your description of the subsection.
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Element

The Simulink element allows you to override the inputs to a Simulink model
with SystemTest test vectors and test variables. You can further map the
model’s outputs to SystemTest test variables for later processing by other test
elements. This means that you can use SystemTest to define, generate or load
input data, feed it into Simulink, run the model while iterating over the input
data, and map the outputs back into SystemTest.

Note To use the Simulink element, you must have a license for Simulink.

Before You Begin (p. 3-3)

Mapping Test Vectors and Test
Variables to a Simulink Model
(p. 3-5)

Using Simulink Model Coverage
(p. 3-19)

Prerequisite steps to take if you
intend to use the examples provided
with the procedures in this chapter

Describes how to map test vectors
and test variables to Simulink
inputs and Simulink outputs to test
variables

Describes how to use the Simulink
Verification and Validation model
coverage feature
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Note In Simulink elements, you cannot have more than one model with the
same name. Each model referenced within a test must have a unique name. If
you ran a test containing two models with the same name, SystemTest would
only use one of the models.




Before You Begin

Before You Begin

This chapter explains the Simulink setup by having you recreate the Simulink
element that is part of the Inverted Pendulum demo. Before continuing, you
should load this demo from MATLAB and delete the Simulink element from
the demo.

The following steps describe how to do this:

1 Start MATLAB.

2 Open the Inverted Pendulum demo.
a Select Start > Demos to open the Help browser.
b Expand the MATLAB list from the left frame of the browser.

¢ Select SystemTest. The SystemTest demos open in the right browser
frame.

d Click “Simulink - Mapping and Overriding Simulink Data Using an
Inverted Pendulum Model.” An overview of the demo opens.

e Click the link “Open the demo in the SystemTest Desktop” at the bottom
of the page.

Alternatively, you can enter the following command at the MATLAB
command line:

systemtest InvertedPendulum
The SystemTest desktop opens with the Inverted Pendulum demo loaded.

3 Click the Simulink element in the Test Browser.
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| Test Browser

t ¥ | x|

| Mew Test Element

F-InvertedPendulum
----- Pre Test
[=-Main Test {32 Iterations)
----- Sirnulink:
----- # | MATLAE
----- Limit. Check
o IF
- Weckar Plok
----- Save Results
----- Post Test

4 Click the Delete element button in the Test Browser button bar or press
the Delete key.
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Mapping Test Vectors and Test Variables to a Simulink

Model

To help you learn how to use the Simulink element, this section walks you
through the configuration of the Simulink element for the Inverted Pendulum
test. The Inverted Pendulum demo includes both a model of the pendulum
and a model of a controller that keeps the inverted pendulum balanced.
Moving the bottom of the pendulum disturbs the equilibrium, causing the
pendulum to move and the controller to rebalance it. The Inverted Pendulum
test varies the mass of the pendulum, the mass of the cart the pendulum is
on, and the distance to the pendulum’s center of mass, testing the robustness
of the controller as it attempts to return the pendulum to equilibrium. Using
the Simulink element in a test lets you vary the model inputs and assess
the model outputs.

The following sections show you how to use a Simulink element in a test:

¢ “Adding a Simulink Element” on page 3-5
e “Overriding Simulink Model Inputs” on page 3-7
e “Mapping Simulink Model Outputs to Test Variables” on page 3-11

This section assumes you have loaded the Inverted Pendulum demo and
deleted the Simulink element, as explained in “Before You Begin” on page 3-3.

Adding a Simulink Element

To add a Simulink element to a test, click the New Test Element button in
the Test Browser and select the Simulink element. If you have a license for
Simulink, the element list contains the Simulink element, as shown in the
following figure.
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| Test Browser X

* & x|

| Mew Tesk Elerment «
[ &% IF
Limit Check:

# | MATLAB ations)
|E| Scalar Plat
wall Sirnulink

?;g Subsection ik
Yeckar Plok

4\ Data Acquisition
4!. Image Acquisition  k
4l Instrument Control b

SystemTest adds the Simulink element to the test and opens the Simulink
element Properties pane.

| Test Browser ’ Properties - Simulink n

t 3| x|

| gt ek B e Sirulink. rode]

=-InvertedPendulum

Mappirigs I Model Coverage |

~Define Model Overrides
t $|F

Mapping Type I Simulink, Data SystemTest Data

‘ [dew Mapping =

\..5ave Results
----- Post Test

Specifying the Simulink Model

When you first add the element, the icon in the Test Browser has a red x,
meaning that the element requires some information. The Simulink model
field in the Simulink element Properties pane is outlined in red, indicating
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that it is a required field. You must specify the model that the Simulink
element will interact with. If the model is on the MATLAB path, you can type
its name in the Simulink model field. If you are not sure of the name, or
the model is not on the path, you can browse to its location using the browse
button.

For the Inverted Pendulum example, type systemtestpendulum in
the Simulink model field and press Enter. SystemTest opens the
systemtestpendulum model in Simulink and opens the Pendulum
Visualization window.

Overriding Simulink Model Inputs

Using test vectors and test variables, you can override the following Simulink
model inputs:

® Block parameters — Described in “Overriding Simulink Block Parameters”
on page 3-7

® Model and base workspace variables — Described in “Overriding to
Workspace Variables” on page 3-9

¢ Inport signals — Described in “Overriding Simulink Model Inport Signals”
on page 3-11

Overriding Simulink Block Parameters

You can override Simulink block parameters with SystemTest test vectors
or test variables. When you run the test, Simulink runs the model using
data provided by SystemTest. Overriding does not change your Simulink
model file; it only overrides in the test. The procedure for creating block
parameter overrides requires that you select your block in the Simulink
model, but everything else you need to do happens within the Simulink
element Properties pane.

To override a Simulink block parameter:

1 In the Mappings tab of the Properties pane for the Simulink element in
SystemTest, find the Define Model Overrides area and click the New
Mapping button, and select Select Block to Add. This opens the model
in Simulink, if it is not already open.
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2 In the Simulink model window, click the block containing the parameter
you want to override. For this example, click the Pendulum block in the
systemtestpendulum model window.

3 In SystemTest, return to the Simulink element Properties pane and, in
the Define Model Overrides area, you’ll see that the Block Pendulum
Parameter was added. If you click the New Mapping button again, you’ll
see that SystemTest also adds an entry to this menu for the block.

~Define Model Overrides —

Mewy happing « | ﬁ‘ %-

Inport Signal
Workspace Wariable
Select Block ko Add ..,

Block 'Pendulurn’ Parameter

In the override table, the Simulink Data field shows that this entry is
linked to the Pendulum block but the question mark (?) indicates that no
parameter for the block has been mapped.

Define Model Overrides —

Mewy Mapping = ﬁ @ | ?x |
| Mapping Type Simulink Data | SystemTest Data
| [Block Parameter Pendulum: ? ol I ol

4 Select the parameter from the block that you want to map. Click the
Simulink Data field for the block and select a parameter from the list. For
the Inverted Pendulum demo example, select Pendulum:Mass of cart

(kg).

5 Specify the SystemTest test vector or test variable you want to map to this
block parameter. Click the SystemTest Data field for the block parameter.
This shows you all defined SystemTest test vectors and test variables
available for mapping. For this example, select cart.
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- Define Madel Overrides -

Mesy Mapping = ‘ﬁ‘ w!,- | ?x |
Mapping Type Sirnulink Data | SystemTest Data
Elock Parameter Pendulurm:iazs of cart (k) L‘” cart LI
maxyvalue =
st_loggedsignal
st_outportzighal
| =t_toworkspace
rMap Simulink Data to Test Yariables - -| LimitResutt
L e
| Mew Mapping = | £+ & | s -
I Mapping Type | Sitmulink Data | sistance _Lﬂ

Overriding to Workspace Variables

You can use a SystemTest test vector or test variable to override either a
MATLAB base workspace variable or a Simulink model workspace variable.
This lets you define test values and conditions in SystemTest and have a
Simulink model act on them.

This section describes how you can use the values in the pend and distance
test vectors to override the model workspace variables masspend and
penddistance in the Inverted Pendulum demo.

To override workspace variables:

1 In the Define Model Overrides area of the Simulink element Properties
pane, click the New Mapping button and select Workspace Variable.
SystemTest adds a row for a new mapping of this type.

~Define Model Crerrides -

Mewy Mapping - | ﬁ‘

Inpark Signal

Workspace Wariable

F Select Block ko Add ...
Block 'Cukl’ Parameter
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2 Select the workspace variable you want to override. Click the Simulink
Data field of this row to see all available base workspace variables and
Simulink model workspace variables. For the Inverted Pendulum example,

select masspend.

Define Wodel Crverrides -

‘ | Mesey Mapping « f -& | ?‘ |
! Mapping Type Simulink Data SystemTest Data
! Elock Parameter Pendulurm:Mass of cart (k) LI cart -

Wiotkspace Variable

penddistance (model workspace)

3 Specify which SystemTest test vector or test variable you want to map to
the Simulink workspace variable. Click the SystemTest Data field of this
row to see all available test vectors and test variables. For this example,

select pend.

| Mesy Mapping =

- Define Madel Overrides

Y

Mapping Type

Simulink Data SystemTest Data

Block Parameter

PerculurnMass of cart (ko) LI cart

Wiorkspace Yariahle

mazspend (model workspac..,

e«

maxvalue
=t_loggedsignal
=t_outportsignal
st_towvorkspace
LimitResult

pend

cart

distance -

4 Repeat steps 1 to 3 to override the Simulink model workspace variable
penddistance with the SystemTest test vector distance.
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[ Defing Madel Overrides -

Mesy Mapping = f éa | é“ |
Mapping Type Simulink Data SystemTest Data
I Elock Parameter Perdulurm:Mass of cart (ko) ﬂ cart L| .
Wiorkspace Yariable masspend (model workspace) _ﬂ pend ﬂ
Wiorkspace YVariahle penddistance (model warksp... __"'_| distance L .

Overriding Simulink Model Inport Signals

As with block parameters and workspace variables, you can use SystemTest
to override a model’s inport signals. This lets you externally manipulate the
input signal of a Simulink model.

You use the same procedure to map an inport signal that you use for mapping
block parameters and workspace variables. Click the New Mapping button
and select Inport Signal. SystemTest creates a new row for the mapping.
Then you can choose the inport signal to override from the Simulink Data
field and select the SystemTest test vector or test variable to be mapped from
the SystemTest Data field.

The Inverted Pendulum demo example does not override any inport signals.

Mapping Simulink Model Outputs to Test Variables

Using test variables you can assign the output from the following types of
Simulink model data:

® Logged signals — Described in “Mapping Simulink Logged Signals to Test
Variables” on page 3-12

¢ Qutport signals — Described in “Mapping Simulink Outport Signals to
Test Variables” on page 3-14

¢ To Workspace blocks — Described in “Mapping Simulink To Workspace
Blocks to Test Variables” on page 3-15

After you map model outputs to test variables, you can incorporate the model
data into SystemTest. This section shows you how to map this data for the
Inverted Pendulum example.

3-11



3 Using the Simulink Element

3-12

Note The output from Simulink models can only be mapped to SystemTest
test variables. You cannot map this output to SystemTest test vectors.

Mapping Simulink Logged Signals to Test Variables

Logged signals are a way to obtain outputs from a model without adding more
outports. Using logged signals, you can identify a particular signal and map
the output to a SystemTest test variable.

To map logged signals to a SystemTest test variable:

1 In the Map Simulink Data to Test Variables area of the Simulink
element Properties pane, click the New Mapping button. From the list,
select Logged Signal. SystemTest adds a row for a new mapping of this

type.

~Map Simulink Cata to Test Yariables -

i Plewny Mapping'li ﬁ‘ 4 | -
. Lljl;ll;lEilj ':'-ignal g I

Ciitport Signal
To ‘Workspace Block

2 Specify the signal you want to capture. Click the Simulink Data field
to see all the signals in the model. For the Inverted Pendulum example,
select pendout.

Note If you added logged signals to your model and they do not appear
in this list, click the refresh button, on the Properties pane next to the
model name, to update the list.




Mapping Test Vectors and Test Variables to a Simulink Model

~Map Simulink Data to Test Variables
Mesy Mapping = t * | ?x |
Mapping Type Sitnulink Data SystemTest Data
Logged Signal pencdout ;I i
Al signals
pencdout

3 Specify the SystemTest test variable to which you want to map the output.
Click the SystemTest Data field and select a test variable. For the
Inverted Pendulum example, select st_loggedsignal.

~Map Simulink Data to Test WVariables

Mesny Mapping = t ‘ | ?" ‘
lapping Tvpe Sirnulink Data I SystemTest Data
Lagged Sighal pendout llj X
-

lirnit

tirne

valles

maxyalle

=t oo hal
=t_outportzignal
zt_toweorkspace j

SystemTest creates the mapping to the test variable.

~Map Sirmulink Data to Test Variables
t 8|7

happing Type Simulink Data

Mewy Mapping ~

SystemTest Data
Logged Signal pendout ﬂ =t _loggedsighal ll
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Mapping Simulink Outport Signals to Test Variables
SystemTest lets you map all outport signals to a test variable for further
processing in SystemTest.

To map Simulink outport signals to a test variable:

1 In the Map Simulink Data to Test Variables area of the Simulink
element Properties pane, click the New Mapping button. From the list,
select Outport Signal. SystemTest adds a row for a new mapping of this

type.
;-r-.ﬂap Sitnulink Data to Test Variahles:

j2l=

. Mewy Mapping -

Logged Signal

il Cutport Signal
f I_‘ To Workspace Elock

2 Specify the outport signal you want to capture. Click the Simulink Data
field and select a signal. For this example, select Outl.

~Map Simulink Data to Test Yariahles -

t 3|

Mewy Mapping -

Mapping Type Sitmulink Data SystemTest Data
: Logged Signal pendout ll =t_loggedsignal ll
|outpart Signal - I - I |
Al signals

3 Specify the SystemTest test variable to which you want to map the outport
signals. Click the SystemTest Data field and select a test variable from
the list. For this example, select st_outportsignal.
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Map Simulink Data to Test Variables -

[y Mapping*| f «5 | ﬁ“ |

Mapping Type Simulink Data SystemTest Data
Logged Signal pendout L] st_loggedsignal LI
Outport Signal Ot x> G
;'
linit
time
ValUES
maxvalue
=t_loggedsignal =l
=t_outpartsignal
=t_toweorkspace ﬂ

SystemTest creates the mapping to the test variable.

~Map Sirnulink Data to Test Wariakles -

Mesy Mapping ~ 1‘ % ‘ ?x |
Mapping Type Sirnulink Data SystemTest Data
Logoed Sighal pendout ﬂ =t_loggedsignal ﬂ
Cutport Sighal Ot L =t_outportsighal ﬂ

Mapping Simulink To Workspace Blocks to Test Variables
When Simulink runs a model with To Workspace blocks, these blocks
save model information in the MATLAB workspace as variables. Using
SystemTest, this data can be mapped to SystemTest test variables.

This section shows how you create To Workspace block mappings in
SystemTest using the Inverted Pendulum demo as an example.

To map the To Workspace block:

1 In the Map Simulink Data to Test Variables area of the Simulink
element Properties pane, click the New Mapping button. From the list,
select To Workspace Block. SystemTest adds a row for a new mapping
of this type.
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~Map Simulink Data to Test VYariables

| Newrl.dapping*| "‘ "" | ﬁ
Logged Signal
Ciitport Signal

P

2 Specify the To Workspace block in the model that you want to capture.
Click the Simulink Data field and select the block from the list. For this
example, select To Workspace.

~Map Simulink Deta to Test Variables

Mesy Mapping = f ‘!— | ?x |
Mapping Type Sirmulink Data SysternTest Data
Logged Signal pendout L‘ =t_loggedsignal Ll
Ctpart Signsl ot L[ zt_outpartzignal ﬂ
To Workspace Block EI

3 Specify the SystemTest test variable to which you want to map the To
Workspace block. Click the SystemTest Data field and select a test
variable from the list. For this example, select New Test Variable to
create a test variable.
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~Map Sitmulink Dsta to Test Wariakles

e Mapping t ‘. ‘ ?x |
Mapping Type Sirnulink Data SystemTest Data
Logged Signal pendout L‘ =t_loggedsignal ll
Cutpart Signsl Ot l‘ zt_outpartsignal ll
To Workspace Block To Workspace el £

titne
vallues

maxvalie
#t_loggedsignal
=t outportzignal
=t_toworkzpace

LitnitFesult

r

SystemTest opens the Edit Variable dialog box. Assign a name to the test
variable and optionally an initial value, and then click OK. Name the test

variable ToWSResult.

Editing: ¥arl

la=d]

X

Marme

ITDWSResurt

Initial value

Assigned in

fpair: Test

(0].%

Cancel
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SystemTest creates the mapping to the new test variable and adds the new

test variable to the list in the Test Variables pane.

~Map Sitnulink Data to Test Variables

e Mapping « t‘ ‘ ‘ ?x |
Mapping Type Sirnulink Drata SysternTest Data
Logged Signal pendout L‘ =t loggedsignal ll
Outpart Sigrisl utt | st_outportsignal ¥ |
To Workspace Block To Workspace L‘ Tui-!‘:!‘SHiasurt Ll
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Using Simulink Model Coverage

The model coverage feature provided by Simulink Verification and Validation
allows you to generate coverage analysis metrics for a Simulink model,
which can be incorporated directly into your SystemTest test. Model
coverage metrics allow you to validate your model by identifying unexecuted
subsystems, unselected switch positions, or untaken conditional transition
paths. You can generate a cumulative coverage report, specify individual
coverage options, or inherit a model’s coverage settings.

Note To use the model coverage feature, you need a license for Simulink
Verification and Validation.

The following basic steps describe the typical work flow to use this feature:

1 Use an existing Simulink element or add one by clicking the New Test
Element button and selecting Simulink.

2 On the Properties pane, browse for your Simulink model using the browse
button next to the Simulink model field.

To see an example, you can run the Signal Builder demo by typing
systemtest SignalBuilderDemo in MATLAB.

3 Configure the Simulink element as described in this chapter, using the
Mappings tab of the Properties pane to define model overrides and map
Simulink data to test variables.

4 On the Model Coverage tab, which appears if you have a license for
Simulink Verification and Validation, select the Enable model coverage
check box. The following figure shows the Signal Builder demo.
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Test Browser

Aox | Properties - Run the model
few: Test Elsment ~ ' 4 | X | Sirnulink, made
[=--SignalBuilderDemo C: |MATLAR |svstembestdamos |systembastafear, rndl
Es-----Pre Test I systemtestsfoar ﬂ “H L:‘ﬁ
If{!---Main Test {4 Iterations)
Run the madel Mappings Model Coverage |
+| Scalar Plaok [¥ Enable model coverage
-5ave Results

~Post Test

% Inherit coverage metric sethings From the model

£ Crverride model coverage metric settings
~Inherited Coverage Metrics

—Coverage Instrumentation Path ' For whole model)

/

Brawse, .. |
—Coverage Mekrics
[ Decision Coverage ¥ Condition Coverage
¥ MCDEC Coverage ¥ Loak-up Table Coverage
[¥ Signal Range Coverage
~Map Coverage Data ko Test Yariable:
Test Vectors | Tesk Variables a x Mew Mapping - f ‘ ‘ ?‘ ‘
| Mew... | Edit... | 4+ 3 | Fx | Caoverage Path MMetric SystemTest Data
Hame Initial Yalus Aissigned In systemtestsfoar/Thr... | Look-up Table Cove... Ll coverage Ll
Ea Coverage ain Tesk

5 If you want to use the model coverage settings you already have on the

Simulink model, select the Inherit coverage metric settings from the
model option. Then go to step 9.

6 If you want to override the existing settings, select the Override model
coverage metric settings option.
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Properties - Run the model X

Simulink model
syatertestsfoar md

I systerrtestzfoar LI % lﬁ

Mappings Model Coverage
¥ Enakle model COvErane
" Inkerit coverage metric settings from the model

¥ Cwerride model coverage metric seftings

—Owerridden Coverage Metrics
—iCoverage Instrumentation Path (W for whole model)
!

Brovwese... |

—Coverage hMetrics

¥ Decision Coverage v Condition Coverage
¥ mcoo Coverage v Look-up Tahle Coverage

v Signal Range Coverage

7 Click the Browse button to specify the Coverage Instrumentation Path.
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C-@ systentestsfoar

—E Engine

—y Threshold Calculation

— Tzer Inputs

—3 Vehicle

—3 shift logic(%tateflowChart)
F-2+ transmission

J |

Ok Cancel

8 In the Coverage Metrics area, select the types of coverage your test
requires. The selected coverage types will be generated and shown in the
coverage report.

Coverage hetrics
¥ Decision Coverage [V Condition Coverage
¥ mecoc Coverage v Loak-up Table Coverage

v Signal Range Coverage

9 Use the Map Coverage Data to SystemTest Variables field to map
coverage metrics to test variables. Click New Mapping and select Full
Coverage Instrumentation Path if you want coverage data below the
root you specified under Coverage Instrumentation Path, or select
Select Path to Map if you want to pick an alternate coverage path, which
must be within the coverage instrumentation path. If you select the latter,
your Simulink model will open and you can select a block to specify an
alternate root for your coverage path.
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10 Select the Metric you want to map to a test variable, and specify the test
variable to use under the SystemTest Data column.

~Map Coverage Data to SystemTest Variables

t 3 |F

Meswy Mapping =

Coverage Path Metric SystemTest Data

systermtestsfearThreshold Calculationinterp_dowen | Look-up Table Coverage LI COVErage

[

11 Run your test.
12 View the coverage report by clicking the link in the Run Status pane.

Getting Started | Desktop Help Run Status A X
Generated Files
Type Location Action
gﬂ;;;rITCoverage CAMATLABVSIignalBuilderDema_results 14962063, ot Launch Model Caoverage Repart for Bun the maodel
Test Results CAMATLABSignalBuilderDermo_results.mat “iew in Test Results Wiewer
Test Report CAMATLABVS IignalBuilderDema_repotiSignalBuilderDemoa_repart.html Yiew Test Repont

Final Test Status

Property Value

Start Time 04-Jan-2007 13:52:53

Stop Time 04-Jan-2007 14:00:08

lterations Completed 4

Final Status Campleted Successfully
Test Skatus: Completed SuccessFully

Time Elapsed: 00:00:15
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For more information on the model coverage feature, see “Using Model
Coverage” in the Simulink Verification and Validation documentation.
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%" systemtestsfcar Coverage Report 1ol x|
File Edit Yiew Go Debug Desktop ‘Window Help £
@ B | é | i | Location: IC:.l’TEMP.l‘SignaIBuiIderDemo_resuIts14952053.Mml Ll
Summary | Details | Signal Ranges | Help
=
Summary
Model
Hierarchy/Complexity: Test1
D1 | MCDC TBL 4] c1—
1. gystemteststear 24 88% T BTV mmmmcin T H% T sy .
2.. .. Engine ] A PA PA, 14% - MA MA
5. Theshold e MA, N, wx 0™ 100% M,
Calculation I I
4. .. ghift logic 22 57% E7% o 33% - A, 58% 35%
5o SR 2 oaTw T o eemin MA 58% e
zhift logic
B S g gy (— M, hA, P, gI e R,
gear_state
7. Lo sF 12 §7% E7% o 33% - A, 53% 35%
zelection state
g. ... transmission 0] A A A 92% A 2
S Torue (17 MA, N, T M, M,
Converter
10.... . ] Y [ [, B0% A, [,
transtmission ratio
Details:
1. Model "systemtestsfcar”
Child Systems: Engine, Threshaold Calculation, shift_logic, transmission
Metric Coverage (this object) Coverage (inc. descendants)
Cyelomatic Complexity 1 24
Condition {(C1) A B7% (8/12) condition outcomes
Decision (D1) My 4% (30/32) decision outcomes
MCOC (C1) A 33% (2/8) conditions reversed the outcome
N . ) )
Look-up Table MA _44 Y (111/251) interpolation/extrapaolation
intervals hd
1| | 3
A
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Using the Instrument
Control Toolbox Elements

Instrument Control Toolbox provides several elements to use in SystemTest.

Introduction (p. 4-2) Introduces the Instrument Control
Toolbox elements

Example: Measuring a Generator’s  Provides a basic example of
Frequency (p. 4-3) using Instrument Control Toolbox
elements to test a device



4 Using the Instrument Control Toolbox Elements

Introduction

Instrument Control Toolbox Elements

This chapter describes how to use the Instrument Control Toolbox elements
with SystemTest.

The Instrument Control Toolbox elements provide a way to bring data from
instruments into a SystemTest test, or to transmit data from your instrument.
You can use these elements along with the other elements in SystemTest to
create tests for Simulink models and other applications.

Note To use the Instrument Control Toolbox elements, you need a license
for Instrument Control Toolbox. These three elements will not appear in
SystemTest without this license.

Instrument Control Toolbox provides three of elements that you can use in
SystemTest:

¢ To Instrument — For sending commands or data to your instrument
¢ From Instrument — For reading data from your instrument

¢ Query Instrument — For querying your instrument status or properties

You can configure these elements to communicate with your instruments by
using SystemTest resources supported by Instrument Control Toolbox.

Accessing Resources

If your MATLAB installation includes elements that require resources, the
SystemTest desktop includes a Resources pane that lets you access the
resources available through these toolboxes. For example, if your MATLAB
installation includes Instrument Control Toolbox, you can see the Resources
pane, if you open it from the Desktop menu. Select Desktop > Resources to
open the pane. It will tab with the Test Vectors and Test Variables on the
lower left corner of the desktop. Resources are toolbox-specific. For example,
an Instrument resource might be configured to connect to a device over your
computer’s serial port.



Example: Measuring a Generator’s Frequency

Example: Measuring a Generator’s Frequency

To illustrate how to use some of the Instrument Control elements in
SystemTest, this section provides a step-by-step example.

In this example a SystemTest element configures a signal generator to
produce signals of various frequencies, which are measured by an oscilloscope
configured by other SystemTest elements.

The signal generator is a Hewlett-Packard 33120A at GPIB address 5, and
the oscilloscope is a Tektronix TDS 210 at GPIB address 4. For this example,
the generator output is fed directly to the scope input. The generator will
be programmed to generate signals of 1500, 5000, and 7500 Hz, while the
oscilloscope will measure each signal’s frequency.

The steps in this example are:

“Setting Up the Signal Generator” on page 4-4

e “Setting Up the Oscilloscope” on page 4-9

¢ “Taking the Measurement” on page 4-11

* “Saving Test Results” on page 4-12

¢ “Running the Test and Viewing Test Results” on page 4-13
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Setting Up the Signal Generator

The first element in the test programs the generator to output signals of
various frequencies. To test at three frequencies, the test be comprised of
three test cases, i.e., three iterations. This is a one-way communication to the
generator, so you use a To Instrument element.

1 Open SystemTest from MATLAB by selecting Start > MATLAB >
SystemTest > SystemTest Desktop. You can also just type systemtest
at the MATLAB command line.

2 When SystemTest opens, ensure that the Visualize and plot saved
results by launching the Test Results Viewer check box is selected in

the Properties pane.

3 No setup is required in the Pre Test, so the elements of this test are all in
the main test, so click Main Test in the Test Browser.

4 Add an element by clicking New Test Element > Instrument Control >
To Instrument.
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| Test Browser

| Mew Test Element » | 00 & | X |
| 5 IF

Lirit Check:
4| maTLAB
[ scalar Plot
Sirrulimk.
0 Stop

Eg’;;g Subsection

Yector Plak

4!. Data Acquisition ¥
4!. Image Acquisition  k
sk Inskrurment Contral @ From Instrument
@ Query Instrument

The element appears in the browser as To Instrument.
5 Double-click To Instrument, rename it Set Generator, and press Enter.

6 From the Properties pane’s Select an instrument resource list,
select New Instrument Resource. The instrument resource is the
communication channel between MATLAB and your instrument, in this
case the generator at GPIB address 5.

7 In the Edit: Instrument1 dialog box, enter Generator in the Name field.
8 Click Create to create an instrument resource.

9 In the New Object Creation dialog box, select GPIB in the Instrument
object type list. Select the appropriate Vendor (in this example, ni
for National Instruments), Board index (0), and instrument Primary
address (in this example, 5).
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#): Hew Object Creation

~Define okject

L]

Instrument ohject type: I GPIE

rConfigure object crestion

wenhdar: I ull ﬂ
Board index: 'J LI
Pritnary address: E ﬂ

ik I Cancel |

10 Click OK to return to the Edit: Instrumentl dialog box, where the
instrument object is now filled in and selected for this resource (GPIBO-5).

Editing: Instrumentl x| |

Marne:

IGeneratDr

Instrurment Ohject

Select an instrurment object for this resource.

Create... |

0104 | Cancel |

11 Click OK to apply this resource and return to the Properties pane in the
SystemTest desktop.

12 In the Command text field, enter frequency followed by a space to
separate the text from the variable that will follow. This is the command to
set the frequency of the 33120A generator, as described in the instrument’s
reference manual proved by the vendor.

13 Click Data source and select New Test Vector. The name of the
vector you create for setting the generated frequencies is called genfregq.
Enter that text in the Name field, and set the Expression field to
[1500 5000 7500], including the brackets.
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Edit Test¥ectorl x|

Marme:

IgenFreq

Expression { example 1:10, or rand(1,25) )
f[1500 5000 7500]

Veckor
|[15|3|3 5000 7500]

Murmber of iterations
|:3

~iarauping

% Ungrouped - This kest veckar will be permuked with
other test veckors in every possible combination,

{~ Grouped - This test vector will be combined sequentially
with all grouped test vectors, and then permuted with
all ungrouped kest vectars in every possible
combinatiarn,

Far example, the Fallowing test veckors wauld produce a
combination of (1,3,5), (1,4,6], (2,3,5), (Z,4,6) when th
test is run:

(1]

UngroupedYectar [1 2]
Groupedvectorl  [3 4]
Groupedvectorz  [S6]

[o]4 Cancel

14 Click OK to return to the SystemTest desktop.
Notice that the Main Test node in the tree now says (3 Iterations).

Because you entered three values in the test vector, the test is comprised of
three iterations, one for each frequency value in the test vector.
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15 Keep the Send variable data as setting as String. The generator is
expecting string values for its commands.

16 Set a pause value of 2 seconds. This allows the generator to settle before
you measure its output.

The element should now resemble the following figure:

Test Browser = A x |Pruperties - Set Generator x
| Mew Test Element - 1' ' | X | rInstrument resource
=-Untitled Select aninstrument resource:
;»-----Pre Test I aenerator LI
E‘ Main Test (3 Iterations) ~Message data and Format
i Set G 14
H @ &t Eneratar Message data: frequency <genfredgr
. ‘-Save Results g
...Post Test Cormand kexk:
IFrequency
Daka source:
| genfreq LI
Send variable data as:
I Skring LI
Pause after sending data {seconds):
Iz
Test Vectors w [0 # X  TeskVariables | Resources
| New. .. | Edit. .. | + 3 | = |
Mame Expression Weckar Iterations | Grouped
genfreq [1500 5000 7500] |[ 1500 5000 7500] 3 Il
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Setting Up the Oscilloscope

You use a To Instrument element, which provides a one-way communication
to the oscilloscope, to program the scope to measure frequency.

1 Add an element by clicking New Test Element > Instrument Control >
To Instrument.

2 Double-click To Instrument in the tree, rename it Set Scope, and press
Enter.

3 As before, create a new instrument resource, but this time call it Scope.
Create a new instrument object for it using Board index 0, and GPIB
primary address 4.

4 For the command text, enter measurement:immed:type frequency. This
puts the scope in the frequency measurement mode, as described in the
instrument’s reference manual provided by the vendor.

There is no test variable or pause required for this element, so the element
looks like the following figure:
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«): SystemTest - Untitled.test™

File Run Toolz Desktop Window  Help
OelDca e 8| 2| . ®
Test Browser LA Sl Properties - Set Scope X
Mesw El it - | |
| S Eeme ' ‘ X rInstrument resource
=-[_] untitled Select an instrument resource:
----- Pre Test I Scope LI
[=-Herations (3}
. [5-Main Test ~Mezsage data and format
@ Set Generstor Message data: measurement : immed: type freguency
B Set Scope Cornitnand text:
. Save Results Imeasuremem:immed:type frequency
SR Data source:
| |
Send variable data as:
I String LI
Pause after zending data (seconds):
Test Vectors A X I
|New|Ed‘rt...|f 3 |§°‘|
| Mame Wectar Walues terations
| genfred [1:500 S000 7500] ([1:500 5000 7500] 63|
Test Wectors | Test Varisbles | Resources
4

To see the resources you created for communications with your two
instruments, click the Resources tab at the bottom of the SystemTest
window. You can see the Generator and Scope resources, along with their
GPIB settings.

“'"N'__.m-r e k. T .

Test Wectors | Test Wariables I Resources I

2

-

Resources A X Ipai
|New' Ed‘rt...|‘l‘ lr|§|"‘| *
Marme Reszource |dentifier 1

(=) Generator GPIED-5 e
=] Soope GPIBO-4 4
4

¥

»

.‘

8
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Taking the Measurement

With the generator and scope set up, you can take the measurement with the
scope using a Query Instrument element, which sends the command to the
scope for taking the measurement.

1 Add an element by clicking New Test Element > Instrument
Control > Query Instrument.

2 Double-click Query Instrument in the tree, rename it Measure with
Scope, and press Enter.

3 Use the existing instrument resource called Scope, by selecting it in the
Instrument resource list.

4 Enter the command to query for a measurement by typing
measurement:immed:value? in the Instrument query command field.

5 Select Store complete response, and select the Empty input buffer
after read check box.

6 From the Interpret data as list, select String (this scope returns ASCII
strings), and select the Convert string value to a numeric result check
box.

7 From the Assign data to list, select New Test Variable. For the
oscilloscope’s frequency measurement, name the test variable scopefreq.

It needs no initial value.

The element now looks like the following figure:
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«): SystemTest - Untitled.test™

File Run Toolz Desktop Window  Help

OO0 8|2l = &
| e Blement = ' G | X | rInstrument resource
& j Untitled Select an instrument resource:
Pre Test IScope LI
C-terations (3)
E---Main Test Euery command

Instrument query command:

Imeasuremem:immed:value?

Q Measure with Scope

“-Save Results
ost Test % Store complete response

Reading data

' Remove the followving header

' Mumber of bytes to remove from start of response

Test Variables W &2 ¥ Emmpty input buffer after read
Merwy + t... | | : |
| =7 Ecit LR - rData format
Marne Initial *alue Azzighed In Interpret data as:
EH =copefreq hizin Test I String LI

V' Corwert string value to a numetric result

~&ssign data
Azsign data to:
I scopefrey LI
Test Wectors I Test Yariables I Resources I
4

Saving Test Results

To view the results of your test, you must first specify the test variables you
want to save as test results. This is done in the Save Results Properties
pane.

1 Click Save Results in the test browser tree.
2 In the Properties pane, click New Mapping.

3 From the Test Variable list, select scopefreq. This test variable contains
the frequency measurements provided by the oscilloscope during each Main
Test iteration, as shown in the following figure:
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| Properties - Save Results

~Map Test Variables to Resulks

with saved test resulks,

H—D_Hx

Specify the test variables you want to save at the end of each Main Test iteration by
mapping a test wariable to a test resulk name.

Moke, test veckors do nok need to be specified. By defaulk, they are made available

MNew Mapping | f ‘ | a‘x |

Test Yariable

Result

scopefreq

[

scopefreq

Running the Test and Viewing Test Results
Now that the test elements are all created, you can run the test.

1 Run your test. When the test is complete, the Test Results Viewer displays

your test results.

2 You can explore and plot your test results using the Viewer. Alternatively,
in the Data pane, right-click the name scopefreq and select Export. This
makes the variable available in your MATLAB workspace.
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C:% Temp'Untitled_results.mat
File Edit Wigw Insert Tools  Constraints Results  Plots  Desl

) Test Results Yiewer -

3
: L |
[ BN [ B e 1 P8
Data 2 X )
R
: w Results |

Mame L Yalue Type

4
4
Create a constraint based on this result or test vector
Rename detived resulk, . .

Edit: expressian...

Expaort result ar kest weckor bo wol

w Testy  Delete derived result k )-
Mame £ IVaIue I IH, }
genfreq  [1.5e+003.5
S R R e

3 To see the measurement results, at the MATLAB prompt type

format short g
scopefreq
scopefreq =
1501.5
5000
7500

This verifies that the signal generator is producing the expected signal
frequencies.
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Using the Data Acquisition
Toolbox Elements

Data Acquisition Toolbox provides several elements to use in SystemTest.

Introduction (p. 5-2) Introduces the Data Acquisition
Toolbox elements

Example: Testing a Voltage Provides a basic example of using

Regulator (p. 5-3) Data Acquisition Toolbox elements

to test a device
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Introduction

Data Acquisition Toolbox Test Elements

This chapter describes how to use the Data Acquisition Toolbox elements
with SystemTest.

The Data Acquisition Toolbox elements provide a way to bring analog and
digital data from a data acquisition device into a SystemTest test, or to send
analog or digital data from your device. You can use these elements along
with the other elements in SystemTest to create tests for Simulink models
and other applications.

Note To use the Data Acquisition Toolbox elements, you need a license for
Data Acquisition Toolbox. These four elements will not appear in SystemTest
without this license.

Data Acquisition Toolbox provides four elements that you can use in
SystemTest:

¢ Analog Input — For reading analog data from your data acquisition device
¢ Analog Output — For sending analog data to your data acquisition device
¢ Digital Input — For reading digital data from your data acquisition device
¢ Digital Output — For sending digital data to your data acquisition device

You can configure each test element to communicate with your data
acquisition devices for sending or receiving digital or analog data.
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Example: Testing a Voltage Regulator

To illustrate how to use some of the Data Acquisition Toolbox test elements
in SystemTest, this section provides a step-by-step example. The example
shows how to use the elements that send data to a device under test (DUT)
and receive data from a device under test, using both analog channels and
digital lines.

This example samples the response of a 5-V voltage regulator that is
stimulated with three different voltages of 4, 5, and 7.5 volts. The regulator
has an enable function controlled by a digital signal. In this example, you
collect 22,000 samples per second of the DUT response for 2 seconds.

All data going to and from the DUT is handled by a National Instruments
PCI-6035E data acquisition card. The example uses this card’s analog output
for the DUT stimulus, analog input for capturing the DUT response, and
digital output for controlling the DUT’s enable line. The test configuration is
shown in the following figure:

National Instruments

PCI-6035E

Analog Output
HW Chan 0

Shmu|us= DUT Response »| Analog Input
HW Chan 3

Digital Output
Enable Port 0, Line 3

The steps in this example are

¢ “Sending Analog Stimulus Data to the DUT” on page 5-4
e “Enabling the DUT with Digital Data” on page 5-7
¢ “Receiving Analog Response Data from the DUT” on page 5-9
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¢ “Disabling the DUT with Digital Data” on page 5-10
¢ “Performing Data Analysis” on page 5-12

¢ “Defining Post Test Elements” on page 5-13

* “Saving and Viewing Test Results” on page 5-14

Sending Analog Stimulus Data to the DUT

Stimulus data is sent to the DUT from an analog output channel of your
data acquisition card.

1 Open SystemTest in MATLAB by selecting
Start > MATLAB > SystemTest > SystemTest Desktop.
You can also type systemtest at the MATLAB command line.

2 This example does not use the Pre Test section, so select the Main Test
section in the Test Browser pane.

3 Add an Analog Output element by clicking New Test Element > Data
Acquisition > Analog Output.
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| Test Browser

| Mew Test Element » | ¢ & | b 4 |
[ & IF

Limit: Check:
4| MATLAE
|E| Sicalar Plak
Sirnlirk:
0 Stop

Eg’;;g Subsection
YWeckaor Plok
4« Daka Acquisition E‘}' Analog Input
cﬁ Image Acquisition | B Analog Output
4\ Instrument Control | 5 Digital Input

1l Digital Cutput

The new element appears in the browser tree, and its properties appear in
the Properties pane. SystemTest scans your computer for installed data
acquisition adaptors and devices. This can take several seconds.

4 Double-click the new Analog Output node in the browser tree, and enter a
new name for this element, such as Stimulate DUT.

5 Since we have three test cases, we need to create a test vector containing
the three voltage settings to test against. Click the Test Vectors tab. The
voltage values for the stimulus to the DUT are held in a test vector. Click
New to create a new test vector.

6 Click the name TestVector1 and enter a new name for your vector, such
as DUTstimulus.

7 Click the default1 : 1 : 10 entry in the Expression column, and
replace it with the values for your test: [4, 5, 7.5] (be sure to include the
brackets) and click OK. Notice that because there are three values in your
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vector, the browser tree now indicates that the Main Test will run three
iterations. Each iteration will use one of the three values in the vector for
the DUT stimulus voltage.

8 In the Properties pane, select the adaptor and device to use for the test.
This example uses the nidaq adaptor, and the device is a PCI-6035E.

9 The example hardware configuration uses the card’s analog output
hardware channel 0 to provide the DUT’s stimulus. So select the check box
for this channel. The element will generate signals of 4, 5, and 7.5 volts, so
keep the default output range of [-10.0 10.0].

10 From the Data source list, select the DUTstimulus test vector.

11 Enter a value of 1 for Qutput rate. You are using a single static value
rather than a sampled waveform, so this is not critical.

12 Enter a value of 1 for Number of times to output data. The card will
hold its last programmed value, so you need to send it only once.
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The Properties pane now looks like the following figure:

«): SystemTest - Untitled.test™

File Run Toolz Desktop Window  Help

o0

CHEER 1A

Test Browser

| Mewe Element ~

* 3| x|

LA Sl Properties - Stimulate DUT A X

Test Vectors A X
|New|Ed‘rt...|‘!‘ §|§'x|

| Mame Wectar Walues tterati...
| DUTstimulus |[4, 5, 7.5] [457.5] 3
Test Wectors | Test Varisbles | Resources

5@

Select Hardware:

Adaptar:

| nickag

Device:

|

| Devz (PCI-6035E)

|

H Channel

Cutput Range

[-10.010.0]

[l i
[} 1

[-10.010.0]

Select Al

Unselect Al

Data source:

| DUTstimuius

Output rate (Samplesisecond):

f

The actual output rate will be 1.

Murnber of times to output deta:

f

Enabling the DUT with Digital Data
To send a digital enable signal to the DUT, use a digital output element.

1 Select New Test Element > Data Acquisition > Digital Output.

2 Double-click the new Digital Output element in the browser tree, and type

a new name for this element, such as Enable DUT.

3 Click the Test Variables tab.

4 Click the New button to create a new variable. You will create two
variables: one for enabling and one for disabling the DUT.

5 Click the name Var1, and replace it with the text DUTenable.

5-7
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6 Click its empty Initial Value entry, and enter 1.

7 Repeat steps 4 to 6 to create a second test variable, but name it DUTdisable
with an initial value of 0.

8 In the Properties pane for the Enable DUT element, select the adaptor
and device for sending this data. Again, you are using the nidaq adaptor,
and the device is a PCI-6035E.

9 The hardware configuration uses the card’s digital output port 0, line 3 for
the enable signal, so select the check box for this line.

10 From the Data source list, select the variable DUTenable.

The Properties pane now looks like the following figure:

«): SystemTest - Untitled.test™

File Run Toolz Desktop Window  Help
Oellcd e 8| 2| L ®
Test Browser LA 8l Properties - Enable DUT A X
|Nev\fEIemer‘ﬂv + 2 | 4 |
Select Hardware:
=-[_] untitled
, ..... Pre Test Adaptor:
- iterations (3} |nidaq =
: Device:
| bevz (Pel-6035E) =]
Part Line
r i i
r i 1
r i 2
7 i 3
r i 4
Test Variabl: E 4 | 0 5
est Variables - o 5
|New' Ed‘rt...|‘l‘ lr|§|"‘| O 0 7
[Marne Initial *alue Azsigned In
HH outensbe | Main Test
HH outdisakie [0 Wair Test
Select Al Unselect Al
Data source:
| DUTenable |
Test Wectors I Test Yariables I Resources I
4
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Receiving Analog Response Data from the DUT

The next element in the test samples the output from the DUT and assigns
the acquired data to a test variable.

1 Select New Test Element > Data Acquisition > Analog Input.

2 Double-click the new Analog Input element in the browser tree, and enter
a new name for this element, such as DUT Response.

3 In the Properties pane, select the adaptor and device to use for the test.
This example uses the nidaq adaptor, and the device is a PCI-6035E.

4 The hardware configuration uses the card’s analog input hardware
channel 3 to read the DUT’s response, so select the check box for this
channel. The expected signal will be about 5 volts, so keep the default
output range of [-10.0 10.0].

5 Set a sample rate of 22000. Because of hardware limitations, the actual
sample rate may not exactly match the value you specify.

6 In the Acquire field, specify to acquire data for 2 seconds. Set seconds in
the unit list to the right of the value field.

7 In the Assign data to field, select New Test Variable from the list. This

is where you specify what test variable to assign the acquired data to. The
Edit dialog box appears.

Editing: Varl |

Marne

I\-’ar1

Initial vwalue
friand

Aszigned in

[iin Test

Cancel |
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8 Enter a name for the test variable, such as DUTresponse, then click OK
to create the test variable.

The Properties pane now looks like the following figure:

: SpstemT est - Untitled_test™

Fil=  Run Toolz Desklop ‘Window Help

IEEEIEEE IR = ®

| Mewy Element ~

t & | x|

~Select Hardware:
=] untitled
| Adaptor:

| niciag LI

Device:
| Deva2 (PCI-G03SE)

=

Save Results = HA Channel Ihput Range
. Post Test 0 [-0.05 0.05] -|
r 1 [-0.05 005
[ 2 [-0.05 0.05]
v 3 [-0.05 005
r 4 _0.05 005
= d (305 B0 =
lEstilaniahics X Select Al Unselect Al
|New- Ed'rt...‘f L ‘?“
— - Sample rate (Samplesizecond):
Mame Initial %alue Azzigned In
0 : 22000
! LTS The actual sample rate will be 22,002.2.
A outdisane |0 in Test ,
Acouire:
HH DUTresponze lizin Test
|2‘ Seconds | * I

44,004 data pointz will be acquired.
Aszigh data o

| DUTresponse LI
Test Vedorsl Test Variab|eg| Resources I

Disabling the DUT with Digital Data

The next step is to disable the DUT with a digital output element that turns
off the DUT’s enable line. This element is similar to the Enable DUT element,
except it sends a different value to the DUT.
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1 Select New Test Element > Data Acquisition > Digital Output.

2 Double-click the new Digital Output element in the browser tree, and
enter a new name for this element, such as Disable DUT.

You already created the test variable DUTdisable, which you will use in
this element.

3 In the Properties pane for the Disable DUT element, select the adaptor
and device for sending this data. Again, you are using the nidaq adaptor,
and the device is a PCI-6035E.

4 The hardware configuration uses the card’s digital output port 0, line 3 for
the enable signal, so select the check box for this line.

5 From the Data source list, select the variable DUTdisable.

5-11



5 Using the Data Acquisition Toolbox Elements

5-12

The Properties pane now looks like the following figure:

«): SystemTest - Untitled.test™

File Edit Run Toolz Deskiop ‘Window  Help

S IEEE =R R

Test Browser

| Mewe Element ~

t | x|

=) untitled

Test Variables A X
|New' Ed‘rt...|‘l‘ 4 |§|"‘|

[Marne Initial %alue Azsigned In
HH outenable |1 htain Test
HH outdisable [0 Main Test
EH DUTresponse Main Test

Test Wectors I Test Variablesl Resources I

| =[]
Properties - Disable DUT A X
Select Hardware:
Adaptar:
| nickag LI
Device:
| bevz (pel-603sE) =]
Part Line
r i i
r i 1
r i 2
~ i 3
O i 4
r i 5
r i 6
r i 7
Select Al
Data source:
| DUTdisable |
4

Performing Data Analysis

At this stage, you might perform any analysis or visualization routines on the
data generated by the DUT. You can do this in a MATLAB element.

1 Select New Test Element > MATLAB.

2 Double-click the new MATLAB element in the browser tree, and enter a
new name for this element, such as Process Data.

3 In the MATLAB Script edit field of the Properties pane, enter any

MATLAB code that you need for analyzing your test variables. You
might be interested in measuring ripple, noise, regulation, or many other
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characteristics. You can access the DUT response by referring to the test
variable DUTresponse. The stimulus data is available in the test variable

DUTstimulus.

The following figure shows a MATLAB element with only some comments
added in the Properties pane.

«): SystemTest - Untitled.test™

File Run Toolz Desktop ‘Window  Help

OOl Ee 8| 2|

Test Browser

Ll Properties - MATLAB

| Mewe Element ~

t 3| x|

=-[_] untitled

’ ----- Pre Test
- iterations (3)
| [El-Main Test
B stimulste DUT

~Save Results

------ Post Test
Test Variables A X
|New' Ed‘rt...|‘l‘ L |§|"‘|
[Marne Initial %alue Azsigned In
HH outenabie 1 Main Test
HH outdisable [0 Main Test
EH DUTresponse Main Test

Test Wectors I Test Variablesl Resources I

MATLAE Script

1 % This i=s a MATLAE element, used to
2 % analyze the DUT stimulus and
3 % response test wvariables.

Defining Post Test Elements

In this example, it is recommended to include an element in the Post Test

section to disable the DUT.

1 Click the Post Test section in the browser tree.

2 Create a digital output element set up like the element you made in
“Disabling the DUT with Digital Data” on page 5-10.
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With the extra Disable DUT element, the test now looks like the following
figure:

«): SystemTest - Untitled.test™

File Run Toolz Desktop ‘Window  Help

e Dceds &2l = .| &
Test Browser LA 8l Properties - Disable DUT A X
| Mewy Element = f G | X |
Select Hardware:
=-[_] untitled
, ..... Pre Test Adaptor:
- iterations (3} | nickary |
. [=-Main Test .
Device:
B stimulste DUT
- -
11} Enatle DUT | G ) [
F_é? DUT Response -
118} Disable DUT = R s
#matLep 0 o
st et — 1
ave Results i 0 2
E---P:Jst Test v o 3
o pifl Disable DUT = 0 3
- O 0 5
Test Variables A X - 0 &
|New' Ed‘rt...|‘l‘ £ |§|"‘| ] 0 7
[Marne Initial %alue Azsigned In
HH outenabie |1 Main Test
Select Al Unselect Al
HH outdisable [0 Main Test
EH DUTresponse Main Test Data source:
| DUTdisable |
Test Wectors I Test Variablesl Resources I

4

The Post Test section of the test could also perform any analysis that requires
completion of all the iterations of the Main Test.

Saving and Viewing Test Results

Before running a test, you must specify which test variables you want to save
as a test result. In the Save Results Properties pane, you select the test
variable that you want to save and map it to a test result name.

Saved test results will be viewable with the Test Results Viewer. To launch
the Test Results Viewer, click on the test name in the Test Browser. In the
Properties pane, make sure the Visualize and plot saved results by
launching the Test Results Viewer option is checked.
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Using the Image Acquisition
Toolbox Element

Image Acquisition Toolbox includes a SystemTest element that you can use to
bring live video data into a SystemTest test.

Introduction (p. 6-2) Introduces the Image Acquisition
Toolbox element

Example: Acquiring Video Data in Shows how to acquire video data
a Test (p. 6-3)
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Introduction

This chapter describes how to use the Image Acquisition Toolbox element
with SystemTest.

The Image Acquisition Toolbox element, called Video Input, provides a way to
acquire live video data in a SystemTest test. You can use this element along
with the other elements in SystemTest to create tests for Simulink models
and other applications.

To learn how to use the Image Acquisition Toolbox element in SystemTest, see
“Example: Acquiring Video Data in a Test” on page 6-3.

Note To use the Image Acquisition Toolbox element, you need a license
for Image Acquisition Toolbox. The Video Input element will not appear in
SystemTest if you do not.
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Example: Acquiring Video Data in a Test

This section provides an example that illustrates how to use the Video Input
element in SystemTest. The example uses the Video Input element to acquire
a single frame of video for each iteration of the test and uses the MATLAB
element to display the acquired image. The steps in this example are:

¢ “Adding the Video Input Element to a Test” on page 6-3

* “Saving and Viewing Test Results” on page 6-8

¢ “Running the Test” on page 6-9

Adding the Video Input Element to a Test

To create a test using the Video Input element:

1 Open SystemTest by selecting Start > MATLAB > SystemTest >
SystemTest Desktop in MATLAB. You can also just type systemtest at
the MATLAB command line.

2 In the SystemTest desktop, start to create your test by selecting Main Test

and adding the Video Input element. In the Test Browser, click New Test
Element > Image Acquisition > Video Input.

6-3
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t & | x|

| Mew Test Element =

& IF

Limit Check
4| MATLAB

|E| Scalar Plak
Sirnulirk:

0 Skap

?;g Subsection
Yector Plok

4!. Drata Acquisition
sk Image Acquisition |fE Wideo Inpuk
4\ Instrument Control

SystemTest adds the Video Input element to the Main Test section of the
test and displays the Properties pane for the Video Input element. (You
can also add elements to the Pre Test or Post Test sections of a test but
this example does not require it.)

In the following figure, note the red x in the Video Input element icon in
the Test Browser. This red x indicates that the element is in an error state.
SystemTest outlines the required fields in red in the Properties pane.
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3 Specify the device you want to use to acquire image data in the Properties
pane for the Video Input element. You must specify the name of the adaptor
you want to use in the Adaptor field, which is a required field. (SystemTest
uses red outlining to indicate required fields that are not filled in yet.)
SystemTest can detect any image acquisition devices supported by Image
Acquisition Toolbox that are connected to your system and fills in this
field with a default value based on the alphabetical list of devices, if one
is available. For our example, in the figure, SystemTest sets the Adaptor
field to winvideo. If your system has other adaptors that can connect to
devices, select the adaptor that you want to use from the Adaptor list.

After the Adaptor field is set, SystemTest fills in the Device, Video
Format, and Selected Source fields with default values. SystemTest
populates the drop-down lists associated with each field with all available
options for the field. Adaptors can support multiple devices and devices
can support multiple formats. SystemTest preselects the default values for
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these fields but lists all available options in the drop-down lists associated
with these fields. The following figure shows the list for the Video Format
field:

«); Properties - ¥ideo Input =1al x|
k]

~lensne SAcouistion Device

Adaptar:

| weinvideo j
Device:

| 1 (BM PC Camera) =l
“ideo Format:

Selected Source:

inputl ﬂ
Previgsw Wincdow: |

Mumber of frames:
fi
Assign dats to

I |

4

4 Specify the number of frames you want to acquire at each iteration of the
test in the Number of frames field, which is a required field. For this

example, we only need to acquire one frame for each iteration, so set this
field to 1.

5 Specify the name of the SystemTest test variable that the acquired video
data will be assigned to at each iteration. This is a required field. You can
select a test variable from the list or create a new test variable by selecting
New Test Variable.
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Azsign data to:

If you select New Test Variable, SystemTest opens the Edit dialog box.
Assign a name to the test variable, or accept the default name, and click
OK. You do not need to assign the test variable an initial value.

Editing: ¥ar1l x|

Marme

I\f’ar']
Initial value
Azsigned in

i T2t

i Cancel |

SystemTest adds the new test variable to the list in the Test Variables
pane.

6 Optionally, verify the Video Input element settings by clicking the Preview
Window button. SystemTest opens a Video Preview window and displays a
live video stream from your camera. You can use this to verify that your
hardware is configured correctly. You should close the preview window
before running the test.

7 To complete this example test, add a MATLAB element to the Main Test
section. In this MATLAB element, call the MATLAB image function to
display the image frame acquired at each iteration.
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This completes this example test illustrating how to incorporate image data
into SystemTest. In a real testing application, you can define test vectors that
determine the number of iterations of your test that SystemTest performs.

You can also compare test variables against defined limits in the Limit Check
element and specify pass/fail criteria.

Saving and Viewing Test Results

Before running a test, you must specify which test variables you want to save
as a test result. In the Save Results Properties pane, you select the test
variable that you want to save and map it to a test result name.
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Saved test results will be viewable with the Test Results Viewer. To launch
the Test Results Viewer, click the test name in the Test Browser. In the
Properties pane, make sure the Visualize and plot saved results by
launching the Test Results Viewer option is selected.

Test Browser 2 X |Properties - Save Results A X
| My BTt t G | X | Map Test Wariables to Results
B Untitled E:
j e | Metwy Mapping | ﬁ !’N gl‘x |
~Pre Test
E]"-Iterations ) Test Yarishble Result

Warl LI e

; ~Save Results
i.post Test

Running the Test

To run the test, do one of the following:

e (Click the Run button.
e Select Run > Run.

¢ Press the F5 key.

While the test executes, SystemTest reports on the progress of the test in
the Run Status pane.

After the test runs, the Test Results Viewer will launch. In the Viewer, select
the type of plot you want to create. For this example, select Image Plot from
the Plots menu or click the Image Plot button in the Test Results Viewer
toolbar.
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Using the Test Results
Viewer

This chapter explains how to use the Test Results Viewer to explore and

analyze your test results.

Before You Begin (p. 7-2)

A Quick Tour of the Test Results
Viewer (p. 7-5)

Viewing Your Test Results (p. 7-7)

Refining Your Test Results (p. 7-25)

Viewing Simulink Time Series Data
(p. 7-34)

Saving and Reloading Test Results
(p. 7-38)

Prerequisite steps to take if you
intend to perform the examples
provided with the procedures in this
chapter

A quick overview of the Test Results
Viewer

How to render plots of your saved
test results

How to use constraints to filter the
test results shown in your plots

How to plot Simulink values with
time data

How to save and reload your test
results and work you do in the
Viewer
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Before You Begin

The examples in this chapter use saved test results from the Throttle demo.
You can follow the explanations by loading and running the Throttle demo

from the MATLAB command line. The Throttle demo is configured to open
the Test Results Viewer upon completing a test.

See the SystemTest Demos page for an explanation of the Throttle demo.

Note This demo will not be listed if you do not have Simulink installed.

To prepare for the rest of this chapter:

1 Start MATLAB.

2 In MATLAB, select Start > Demos to open the Help browser opens.

3 Expand the MATLAB list from the left frame of the browser.

4 Click SystemTest. The SystemTest demos open in the right browser frame.

5 Under Simulink, click Validating a Throttle Body Model. An overview
of the demo opens.

6 Click the link Open the demo in the SystemTest desktop at the bottom
of the page.

Alternatively, you can enter the following command at the MATLAB
command line:

systemtest demosystest_throttle

After the SystemTest desktop appears, run the loaded test. Do one of the
following:

¢ (Click the Run button.
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® Press the F5 key.

® Select Run > Run.

SystemTest runs the Throttle demo test, saves the specified test results, and
opens the Test Results Viewer when it finishes.
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Note The most common use case is to have the Viewer open automatically
after a test run, as described here. But you can also open the Viewer directly
from MATLAB by typing stviewer at the MATLAB command line. The
Viewer would open in an empty state. To open test results then, use the File

> Load Test Results menu command.




A Quick Tour of the Test Results Viewer

A Quick Tour of the Test Results Viewer
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The Test Results Viewer is organized to show you the test vectors you specified
as inputs to your test, the results saved from your test, and tools you can use
to plot and examine your test results.
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Plot display options

The test results and test vectors from your test are available in the Data
pane, which is a compact data browser. You choose your plot type, set your
display options to include what appears on the different axes, and plot your
data. The plotting tools let you select data from the plot to examine, and
you can see the actual values that resulted in individual plot points in the
Current Iteration pane, which will open automatically when you select a
plot point. If this pane is not visible, select Desktop > Current Iteration.
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“Viewing Your Test Results” on page 7-7, “Refining Your Test Results” on page
7-25, and “Viewing Simulink Time Series Data” on page 7-34 explain how to
use the Test Results Viewer to plot and examine your test results.
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Viewing Your Test Results

This section explains how you analyze your test results by using the Test
Results Viewer. It contains the following sections:

e “Reserved Keywords” on page 7-7

¢ “Browsing Results” on page 7-7

® “Generating Plots” on page 7-8

e “Exploring Plots” on page 7-12

Reserved Keywords

The Test Results Viewer has several reserved keywords that you cannot use
as a test result name or as a derived result name. These keywords are:

* time

® testrun
® testruns
* metadata

* data

If any of these keywords are used as a test result name, they will be prepended
with "st_" when loaded in the Test Results Viewer. If you try to use these
keywords as a derived result name in the Test Results Viewer, you will get
an error dialog.

Browsing Results

“Viewing Test Results in the Test Results Viewer” on page 1-39 notes that the
Test Results Viewer contains a data browser within the Data pane. This area
of the viewer is one of the first things you see when the Test Results Viewer
opens. It shows you the test variables and test vectors your test used, and it
shows information about their values in the Data Statistics area.

These data statistics summarize the values of a test result or test vector
across all of the tests. For example, the Throttle demo varies the parameters
for mass, damping, and stiffness of a Simulink model. Test vectors vary
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Simulink block parameters for 90 test iterations, and SystemTest saves
how these changes affect the position of a simulated throttle opening in the
position_sim test result.

If you click position_sim in the Results area of the Data pane, the Data
Statistics area shows you a summary of statistical information for all 90
iterations. In this example, you have not defined any constraints on your data,
so statistical information for the constrained and unconstrained columns is
the same. See “Creating and Applying Constraints” on page 7-25.

| w Data Statistics: position_sim i Refrash |
Statistic Unconstrainedd Conztrained

High §6.9 56.9

Loy 23.4 23.4

hiean 651 651

hedian 54.5 54.5

STD 26.6 26.6

“Generating Plots” on page 7-8 explains how you can further explore your
test results.

Generating Plots

The Test Results Viewer has a plotting capability that helps you understand
your test results. You can determine how values of different inputs (test
vectors) affect the overall test results.

To generate any plot:

1 Click the button corresponding to the type of plot you want to generate.
The plot buttons are below the menu bar. For example, click the Line Plot
button. See “Choosing a Plot” on page 7-11 for an explanation of your
choices. You can also use the Plots menu to generate plots.
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« ): Test Results Yiewer - C:h\Ten

File Edit Wiew Insert Tools

Dl

Line Plak

2 Choose the data to use for your X-axis and Y-axis in the Define Plot pane.
For example, select *Auto* from the X Axis list and position_sim from
the Y Axis list to show the simulated throttle position trajectories at each
test iteration. See “Choosing a Plot” on page 7-11 to understand which
data types are available on each axis.

Define Plok: Line Plot 1 A X
Plat type: Line l‘ “alid plot of unconstrained data with 90 line(s)
Kbz |ttt R4 -]

Showy I LI az |subplu... L‘ =
arl I ll az Isuhplu... ll ek

k|

Copy Settings | Refresh Plot |

W Axis

Multiple % Data

3 Choose a different plot type if you do not want to use the default. To choose
a different plot type:

a Click Plot type in the Define Plot pane.

Define Plot: Line Plot

Plot type:

hultiple % Data
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b Click the plot type you want to use. For the Throttle demo example,
use the default sine wave.

4 Click the Plot button. The Test Results Viewer renders a plot based on
your selections.

Plots - Line Plot A X

HE | h|RaM®(E 08| 6 BODEF0 »x

Line Plot: position_sim vs. Index
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Each line in the plot represents a test iteration. If it appears that there are
not as many lines as you had test iterations, it is possible that two or more
iterations generated similar enough results that they overlap.

Now you can analyze the plot. To help you with this task, you can:

¢ Explore the plot using the plotting tools available to you as explained in
“Exploring Plots” on page 7-12.

® Refine what results are shown in your plot as explained in “Refining Your
Test Results” on page 7-25.
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Choosing a Plot

There are six types of plots. The line plot, mesh plot, and time series plot
types have additional subtypes available. Additionally, the Test Results
Viewer has rules for determining which test results you can plot on the X-axis,
Y-axis, and Z-axis. These rules vary by plot type. The following table explains
these selections:

Plot Description

Line Standard line plot of Y versus X. Represents scalar or vector
data. The default is a wave line, but you can choose a square
T line sub type. The following data are allowed on each axis:

e X — Numeric test vectors

¢ Y — Numeric test results

Surf Wireframe surf plot based on X, Y, and Z coordinates.
Optional surface sub type available. The following data are

L"ﬁ";h'- allowed on each axis:
e X — Numeric test vectors
¢ Y — Numeric test vectors

e 7 — Numeric test results

Scatter Standard scatter plot of X and Y where either axis can have
numeric test vectors or numeric test results.

+
+ +*

Time Series Plots time series data Y against time (X is always time).
Designed to represent Simulink time series object data. The
"_f_,l default is a wave line, but you can choose a square line sub

+—+ type. See “Viewing Simulink Time Series Data” on page
7-34 for more information about this plot type.
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Plot Description

Waterfall Waterfall plot for vectors or time series. One vector or time
series can be displayed on each waterfall plot. The meaning
I__.-'__'-_I_'l_ of the X, Y, and Z axes is as follows:

e X — Is automatically selected to be “*Auto*” if the Z axes
is assigned to a vector-valued test result, or “Time” if Z
axes is assigned to a time series test result.

¢ Y — You can select either Test Run or Iteration. In
the former case, if a test is excluded by application of
constraints a gap will appear in the waterfall plot at the
Y position corresponding to that test. In the latter case,
lines representing the test result displayed on the Z axis
are always placed in consecutive Y positions.

® 7 — You can select either a single vector-valued numeric
test result or a single time series test result.

Image Lets you look at individual frames from an image sequence
saved during a test iteration. Data must be a supported
m MATLAB Image format, and must be numeric test results
-;ﬁ whose size is compatible with an image, namely that:

e It has three or four dimensions.

® The third dimension has a length of 1 or 3.

Exploring Plots

This section describes the tools the Test Results Viewer makes available to
help you understand its generated plots. It contains the following topics:

* “Plotting Tools” on page 7-13 describes the tools available to help you
examine and understand the contents of a generated plot.

* “Viewing Individual Iteration Values” on page 7-13 shows how to focus on
specific iteration test results in a plot.

e “Highlighting Values in Your Plot” on page 7-17 shows how to distinguish
test results in a plot.
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¢ “Exposing Overlapping Plot Lines” on page 7-21 explains how you can view
individual lines in a plot that shows multiple test result values as the same
line.

Plotting Tools

The Test Results Viewer integrates the MATLAB Figure Toolbar, which
lets you examine and distinguish the test results shown in your plots. See
“Plotting Tools—Interactive Plotting” and “Data Exploration Tools” in the
MATLAB Graphics documentation for more information.

In addition, the viewer also supports the desktop arrangement tools available
in the MATLAB editor. See “Arranging the Desktop — Overview” in the
MATLAB documentation.

The Test Results Viewer adds the following features to the MATLAB Figure
Toolbar:

e Test run selection — Lets you click different test runs in the plot and see
the test vector and test results for that iteration in the Current Iteration
pane. “Viewing Individual Iteration Values” on page 7-13 shows an example
of how to use this.

® Lock the plot — Prevents constraints from changing the test results
displayed in the plot.

Viewing Individual Iteration Values

Every test iteration has its own representation in a plot unless you screened
it out with a constraint (“Refining Your Test Results” on page 7-25 explains
constraints). By clicking a line, marker, or surface in a plot with the test run
selection tool, you can see the information associated with that test iteration
in the Current Iteration pane.

For example, “Generating Plots” on page 7-8 demonstrates how to generate
a plot showing all test iteration results of the Throttle demo. You can use
the Test Results Viewer plotting tools to zoom in on areas of the plot and
determine which iteration was responsible for the result.

1 Click the Zoom In button.
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2 Move the mouse pointer over an area of the plot you want to investigate
further.

3 Left-click your mouse or click and drag over the area you want to see. The
plot redraws to show this area.

Line Plot: position_sim vs. Index
T T T T T T

position_sirm
[ux) =)
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30 400

1 1 1
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Index

You can repeat zooming in until you have the level of detail you want.
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Line Plot: position_sim vs. Index
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4 To turn off the Zoom, click the Zoom In button again.

5 Click the Select an iteration button in the Figure Toolbar.

<} Plots - Line Plot 1

HE LK RAQAN|E|DET S

| Select an iteration

6 Click one of the plotted lines in the line plot. The viewer marks the line.
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The viewer simultaneously populates the Current Iteration pane with
information about the values for all test vectors and test results for your
selected test iteration. This lets you easily see what test conditions generated
a specific result.

Current Iteration - T 4
Export...

Result Yalue |
pazs_fail 0 &
pozition =780 double=
poition_lirmit 25
position_norm 97.9 =]

Test Wector Yalue |
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liffress 15
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Highlighting Values in Your Plot

The Test Results Viewer lets you further distinguish your test results for any
given plot by letting you control how a plot renders the data on each axis.
This is useful in deciphering test results on a plot—especially when the initial
plot has a large number of test results closely grouped together. This section
explains how you use the Define Plot pane to modify the appearance of your
plot without modifying the underlying test results. (See “Refining Your Test
Results” on page 7-25 for information about modifying the test results used
to render a plot.)

The Define Plot pane provides four ways to distinguish plotted test results:

¢ Color

® Markers

¢ Subplot rows

® Subplot columns

For example, the Throttle demo shows the effect of variations in mass,
damping, and stiffness on a component of a Simulink model. The plot you
generated in “Generating Plots” on page 7-8 shows test results for of all test

iterations, but it is impossible to determine how changes to each test vector
affected this outcome. To distinguish the test results on the plot:

1 Zoom in on an area of the line plot so that you can see individual test

iterations (as explained in “Viewing Individual Iteration Values” on page
7-13).
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Line Plot: position_sim vs. Index
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2 In the Define Plot pane, click Show > Damping.

Define Plot: Line Plot 1 ERD ¢
Plot type: I Line :J “alid plot of unconstrained data with 90 linels)
Ko | rsuto’ =] =]
Showe LI as Isubplot roE it | =
N i | position_sim bl
an as Isubplot columns ¥ | =
Mass
Stiffness
I
Muttiple ** Data Copy Settings | Refresh Plat |

3 Select color from the as list.

4 Click the Refresh Plot button. The plot lines change to show a range

of colors.
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Line Plot: position_sim ws. Index
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You now have some idea how damping has affected the test results. You have
a cluster of blue, green, and red indicating that damping is the same value in
each cluster, which you can confirm by using the test selection tool to choose
lines and by viewing the value for the Damping test vector in the Current
Iteration pane.

You can modify the appearance of another set of test vectors to further
understand the test results. For example, the menu below Damping can be

used to distinguish variations in mass with markers.

1 Click the menu next to and.

=
Showe I Darnping - | as I color - | -
and I o | as Isubplm columnzs ¥ | ol
Dramping
Mass LI
Sliffness

Copy Settings | Refresh Plot |

2 Select Mass from the list.
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3 Click the menu next to as and select marker type.

-l
Shosny I Damping hd | as I color hd | =
ahd I hazs > | az | subplot colurnns . | — ar
subplat roves
subplot columns
color LI
mArkerivpe RS |

4 Click the Refresh Plot button.

The viewer redraws the plot to show markers distinguishing variations in
mass. Notice how each cluster of lines has its own unique color and marker,
which shows that variations in damping and mass have a visible effect when

you run the model.

Line Plot: position_sim vs. Index
T T T

76_ 30

280" 300 310 20

|
260 270 280

You can add two more rows using the + button in the Define Plot pane to
distinguish your test results further.
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as | colar - -

Add a row
L—
as |marker type | - +—]

Note These colors and markers do not necessarily show the same value
throughout the overall plot. The viewer cycles through all colors and markers
in the palette making it possible for different test result values to have the
same color or marker.

Exposing Overlapping Plot Lines

It is possible for plot lines and points to overlap and appear undistinguishable.
When multiple lines overlap, you can create subplots to distinguish the data
points.

For example, if you create a line plot for the Throttle demo with the X-axis

set to *Auto* and the Y-axis set to position_sim, the Test Results Viewer
renders a plot with plot lines in close proximity.
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This plot has 90 lines that are too close together to be able to discern clear
patterns. You can use the Define Plot pane to distinguish plots of test results
by placing the generated lines of a test in individual subplots. Each subplot
shows the test vector values associated with the test results being plotted.
The number of runs per test vector value determines how many subplots you
can generate. Using the Throttle demo, you can generate subplots based on
changes in damping, mass, or stiffness. For example, what effect did changes
in mass have on these test results? To show its effect:

1 In the Define Plot pane, select Show > Mass.
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Define Plot: Line Plot 1
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2 Select subplot rows from the as list.
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3 Click the Refresh Plot button.

The viewer now shows three subplot diagrams, one for each value of the

Mass test vector.
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Line Plot: position_sim vs. Index
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Refining Your Test Results

This section explains how you create and apply constraints to restrict the test
results to a subset of test iterations. You also see how to use a constraint to
walk through a set of test results. This section contains the following topics:

® “Creating and Applying Constraints” on page 7-25
® “Plotting Single Iterations” on page 7-32

Creating and Applying Constraints

Constraints are a Test Results Viewer mechanism that screen out test result
values. Constraints can be a single value, a range, or an evaluated expression.
Applied constraints result in plots rendered from a subset of test iterations,
and the viewer applies constraints immediately to all plots. This is useful
when you want to screen out or filter test results in your attempts to find

or understand the results of a test.

Using Default Constraints

The Test Results Viewer, when opened after a test run, has constraints
present but not applied. The viewer creates a constraint for each test vector
and defines the constraint’s range as a function of the full range of values in
the test vector. These default constraints let you see the immediate effect of
your test’s test vectors on the results of the test.

For example, the Throttle demo has three test vectors corresponding to
changes in damping, mass, and stiffness to a Simulink model. If you display a
line plot as explained in “Generating Plots” on page 7-8, you get a plot similar
to the following:
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Line Plot: position_sim vs. Index
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This output shows that the test results group in small clusters. You can use a
constraint to see which of the test vectors cause this clustering.

1 Return the plot to the previous state by clicking the menu next to as and
clicking color, then click the Refresh Plot button.

2 In the Constraints pane, select the check box next to the Damping
constraint. The constraint becomes active showing all tests with a Damping
greater than or equal to 5.0, which is the lowest value in the range of test
vectors. All test results remain in the plot.
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Constraints A X
t &5
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|

3 Click the right-pointing arrow at the end of the Damping constraint’s
slider.

4 _j— p— Click this arrow

a T3

This advances the constraints slider by one value of the test vector, which
causes the first value of the Damping test vector to be removed from the test
results used in generating the plot. The viewer immediately applies this
constraint to the plot, which, in this case, removes the left-most cluster of test
results from the plot.
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Line Plot: position_sim vs. Index
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The constraint counter gives another way for you to see whether the constraint
affected the test results. In this case, if you set the constraint value to 7, the
bar shows that there are only 72 of 90 test iterations visible because of the
constraint you just created. Thus these 18 test iterations that are screened
out have a Damping test vector value greater than or equal to 7 (see “Creating
a Test Vector” on page 1-13 to understand test vector values).
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Creating a Constraint

The Test Results Viewer lets you create a custom constraint based on the
following:

* A mathematical expression

Scalar logical test results

Scalar numeric test results

String test results that have a value for each test iteration

Test vectors

You can see an example for creating a constraint based on a mathematical
expression in “Viewing Test Results in the Test Results Viewer” on page 1-39.

A constraint you might want to create regularly would isolate test results
that have passed or failed. This is useful if your test contains a Limit Check
element that assigns data to a test variable that you choose to save as a test
result. When this test variable is saved, SystemTest records the test iteration
and whether the test passed or failed (represented by a 1 or 0); you can create
a constraint based on these test results. For example:
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1 If you activated the Damping constraint in “Using Default Constraints” on
page 7-25, deactivate it now by clearing the check box next to Damping,
or delete it.

2 Click the New Constraint button.
Constraints a X

=D * &5

New constraint button

The Add a New Constraint dialog box appears.

3 Click the list beneath the Using a result or test vector field to show the
list of test vectors and test results available for basing a constraint on.

« ) Add a New Conskraint x|

* Uzing a result ar test vector

Dammping b

Mas=z

Hiffhess
position_novm
poasition_limit
pasz_fail

[0 | Cancel

4 Scroll down and select pass_fail in this list. This is the name of the test
result that is used to save the Throttle demo’s Limit Check element’s
output.

5 Click OK. The viewer adds the new constraint to the Constraints pane,
but it is not active.

6 Select the check box next to the pass_fail constraint to apply it.
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4 J— »
] 1

7 Change the operator to ==. The value is already set to 0, representing
failed test iterations.

You now have a constraint set to show only those test iterations that failed.

Line Plot: position_sim ws. Index
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If you change the value of the constraint to 1 using the slider, you will show
only those test results that passed the Limit Check element in your test.
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Line Plot: position_sim vs. Index
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Plotting Single Iterations

The constraint option Plot single iteration at a time lets you step through
and see individual test results within the subset defined by the active
constraints. The plot shows only one test iteration until you choose to show
the next or previous one. The specific values for that test iteration’s test
vectors and test results appear in the Current Iteration pane. This is useful
when you want to know what combination of test vectors allow a test to pass,
or what values can lead to failure.

For example, if you follow “Creating a Constraint” on page 7-29, by the end
you have created a constraint that shows you all test iterations that have
passed. To see each iteration individually:

1 Move the slider for the pass_fail constraint back to 0.

2 Select the Plot single iteration at a time check box in the Constraints
pane.
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The Constraints pane changes to show a slider and the currently
displayed test iteration.

3 Move the slider or click the advance button to see the next iteration. You
see only those test results that match any defined constraints, which, in
this case includes only those tests that have passed.
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Click here to advance

The Plots pane updates to show only the plotted line for that iteration.
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Viewing Simulink Time Series Data

The Test Results Viewer lets you plot test results over time. Simulink can
generate time series data when it runs a model, and SystemTest can use this
data to generate time series plots. Instead of knowing simply that a change in
a test vector resulted in a specific test result value, you can now know when
during the test that the test vector caused that test result value to be achieved.

This section shows how you plot test results containing time series data. The
examples in this section use the model from the Inverted Pendulum demo;
if you want to load this model and follow the examples in this section, see
“Before You Begin” on page 3-3.

Creating a Time Series Plot

Time series plots require that you have time series data. Your test results will
contain time series data because of any of the following:

¢ Time series data is generated from Simulink Outport Signals, Simulink
Logged Signals, and Simulink To Workspace signals.

¢ The time series data was explicitly created in a MATLAB element and
assigned to a test variable that was saved as a test result.

® The viewer created a derived result that represents time series data
constructed from Simulink structs (with time data) or log signals. These
new derived results have names derived from their original test result
name and value.

You can verify whether your test generated time series data by reviewing the
test results list in the Test Results Viewer’s Data pane. The viewer labels
time series test results as being of type Simulink.Timeseries (Simulink
saves time series data within the workspace in Model Data Logs objects).
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To create a time series plot:

1 Run the test in SystemTest.

2 Click the Time Series Plot button in the viewer.

| « ): Test Results Yiewer - C:\ Temp

: File Edit View Insert Tools Cc
D ==

vata Time Series Plat
. Ime 2eries Fo
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3 In the Define Plot pane, click the Y Axis menu to show a list of test results
with time series data. The Y Axis field shows only test results with time
series values. The X Axis field is always set to Time in a time series plot.

Define Plot: Time Series Plot 1
Line ﬂ
w Axis: Tirme

Y Axis ! LI

Plat type:

=t_loggedsignal

=t_outportsignal_signall
=t toworkspacesysterntestpendulumToworkspace
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4 Click the test result you want to use. For the Inverted Pendulum example,
click st_loggedsignal.

5 Click the Refresh Plot button.

The Test Results Viewer generates a time series plot with your selected data.

Time Series Plat: st_loggedsignal ve. Time
150 . . .

100

50

st_loggedsignal
(|

-60

-100

-150
0

M -

10 15 20
Time

At this point, you can use the data exploration and refinement tools explained
in “Viewing Your Test Results” on page 7-7 and “Refining Your Test Results”
on page 7-25 to make more sense of the test results in the plot.
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For example, you can use a constraint to step through each individual
iteration, by selecting the Plot single iteration at a time check box.

? X lE Plots - Time Series Plot 1

A x

FEIRIEESIEINER:

HOBEAO »x

Data
(] B B
* Results |
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:H st_titne =201x1 double= Rawy array
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@lsl_luggadsignal {1007x1 Simulink. Timeseries}  Ohiectfstruct
€| =t_outportsignal {11 struct} Ohjectfstruct
‘Elst_t neorkEpace {1x1 struct} Ohjectistruct
it b i Bt i =
W Test Yectors |
hlame £ |Value |
:H penid =4 dlouble=
cart =4x1 double=
HH distance  [0.7,0.72]
w Data Statistics: limit i Refresh
Statiztic Unconstrained Conztrained
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Iir 1
hean 1
hedian 1
STD ]
I
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ERE +$F
4 l— 3
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015
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Time Series Plot: st_loggedsignal vs. Time
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Define Plot: Time Series Plot 1

Piottype: |V Line

X Axis

W AXIE

Titne
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I st_logoedsignal

Multiple " Data

|

= I LI as Isubpl j - ;I
andl Llaslsubpl.. j - +

|

Copry Settings | Refresh Plat |

As this example shows, the time series test result for a single test iteration
is composed of many values over time. There are many points with uneven
spacing reflecting the actual values of the signal over the time period.
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Saving and Reloading Test Results

You can save the plotting and analysis work done in the Test Results Viewer.
Data, constraints, and plots created in the Test Results Viewer can be saved
and then reloaded in order to continue working on or viewing the data, or to
share it with others.

The following information will be saved:

® The data set created by SystemTest during your test run.

Derived variables you create in the viewer.

The layout state of the data tables (the order of the columns).

Any constraints that you set up, and their order.

Any plots you create, and their layout within the viewer.

Note Since any modifications made in the viewer could potentially be saved,
you will see the “file modified” indicator as soon as you do any actions in the
viewer, that is, the asterisk denoting a file as modified will be shown in the
viewer title bar.

Saving Test Results

To save your test results and the state of the Test Results Viewer, use the File
> Save Test Results or File > Save Test Results As commands from the
Test Results Viewer desktop.

When you use these save commands, a MAT file is created that contains all of
the information listed above.

Loading Test Results
There are four ways you can load test results in the Test Results Viewer.

® Load a saved results file from the File > Load Test Results menu in the
Test Results Viewer desktop.



Saving and Reloading Test Results

® Load a saved results file from the MATLAB command line by typing
stviewer('matfilename'), where 'matfilename’ is the name of the MAT
file containing your results.

® Open the Test Results Viewer automatically after a test runs in SystemTest.
To do this, be sure that the Visualize and plot saved results by
launching the Test Results Viewer option is selected in the Test
Properties pane in the SystemTest desktop before you run the test. After
the test executes, the Viewer is opened and the test results you mapped
in Saved Results are displayed.

¢ Open the Test Results Viewer any time after a test runs in SystemTest
by using the Tools > Test Results Viewer menu command or the Test
Results Viewer toolbar button from the SystemTest desktop. The results
of the last test that was executed will be opened in the viewer.
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SystemTest Hot Keys

The following keyboard shortcuts are available in SystemTest.

Key Description

Alt+N Activates the New button to create a new test
vector or test variable.

F1 Opens Help.

F5 Runs a test.

Ctrl+C While a test is running, stops the test.

Ctrl+C When a test is not running, copies selection in
some parts of the user interface.

Ctrl+N Adds a new untitled test.

Ctrl+O Opens a test.

Ctrl+Q Closes SystemTest.

Ctrl+S Saves a test.

Ctrl+V Pastes the copied selection.

Ctrl+W Closes a test.

Ctrl+X Cuts a selection in some parts of the user
interface.

Ctrl+Y Performs redo of last undo action.

Ctrl+Z Performs undo of last action.

Ctrl+0 Gives focus to the Test Browser.

Ctrl+1 Gives focus to the Properties pane.
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Key Description

Ctrl+2 Gives focus to the Test Vectors pane.
Ctrl+3 Gives focus to the Test Variables pane.
Ctrl+4 Gives focus to the Resources pane.
Ctrl+5 Gives focus to the Run Status pane.
Ctrl+6 Gives focus to the Desktop Help pane.
Ctrl+7 Gives focus to the Elements pane.
Ctrl+8 Gives focus to the Getting Started pane.
Ctrl+Shift+0 Gives focus to the Plots pane.
Ctrl+Shift+U Undocks the currently selected pane.
Ctrl+Shift+D Docks the currently selected pane.
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